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Getting started

Important notices
Intended use
The measurement of oxygen uptake during sport or real life activities is of great interest
for the development of training programs and the study of their effects on elite athletes
or for assessing the efficacy of a rehabilitation therapy.
A common method for assessing the effects of endurance training is the monitoring of
various respiratory parameters during submaximal exercise.
One difficulty to achieve this goal during sport that cannot be simulated in the
laboratory is to use a reliable and valid portable system to measure VO2 and VCO2 in a
field setting.
Such a portable apparatus may also be useful to determine the energy cost of many sport
and real life activities.
K4 b2 is an electrical medical device designed to perform pulmonary function tests. It is
to be used by physicians or by trained personnel on a physician responsibility.
Caution: Federal law restricts this device to sale by or on the order of a physician.
This equipment has been conceived with the aim of providing an auxiliary instrument
allowing:
•

the formulation of lung pathology diagnosis;

•

important studies concerning human physiology;

• the collection of important information in sport medicine.
No responsibility attaches COSMED Srl for any accident happened after a wrong use of
the device, such as:
•

use by non qualified people;

•

non respect of the device intended use;

•

non respect of the hereunder reported precautions and instructions.

Warnings
The device, the programme algorithms and the presentation of measured data have been
developed according to the specifications of ATS (American Thoracic Society) and
ERS (European Respiratory Society). Other international references have been followed
when these were not available. All bibliography references are reported in Appendix.
The present handbook has been developed with respect of the European Medical Device
Directive requirements which sort K4 b2 within Class II a.
It is recommended to read carefully the following precautions before putting the device
into operation.
The precautions reported below are of fundamental importance to assure the safety of
all COSMED equipment users.
1. This user manual is to be considered as a part of the medical device and should
always be kept on hand.
2. Safety, measure accuracy and precision can be assured only:
• using the accessories described in the manual or given with the device. Actually
non recommended accessories can affect safety unfavourable. Before using non
recommended accessories it is necessary to get in touch with the manufacturer;
• ordinary equipment maintenance, inspections, disinfection and cleaning are
performed in the way and with the frequency described;
• any modification or fixing is carried out by qualified personnel;
• the environmental conditions and the electrical plants where the device operates
are in compliance with the specifications of the manual and the present regulations
concerning electrical plants. In particular grounding reliability and leakage current
suppression can only be assured when the device three – wire receptacle is
connected to a yellow - green return connected to earth ground. Attempting to
defeat the proper connection of the ground wire is dangerous for users and
equipment.
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3.
4.
5.

6.

7.

8.
9.
10.
11.
12.
13.
14.
15.
16.

17.

18.

Before powering the system, check the power cables and the plugs. Damaged
electrical parts must be replaced immediately by authorised personnel.
Large gas cylinders, which may be given by the manufacturer or purchased by the
customer, should be secured with cylinder safety chains or safety stands.
When removing the protective cap, inspect the cylinder valve for damaged threads,
dirt, oil or grease. Remove any dust or dirt with a clean cloth. If oil or grease is
present on the valve of a cylinder which contains oxygen, do not attempt to use.
Such combustible substances in contact with oxygen are explosive.
Be certain that the materials of the pressure regulators are chemically compatible
with the intended gas service before installation. Inspect the regulator for the proper
connection and note the ranges of the pressure gauges. Also examine the physical
condition of the regulator including threads and fittings. Remove any dust or dirt
from the regulator or cylinder valve with a clean cloth. Do not install a regulator on
a cylinder valve containing oxygen if grease or oil is present on either. Such
substances in contact with oxygen are explosive.
Cleaning residue, particulates, and other contaminates (including pieces of torn or
broken components) in the breathing circuit pose a safety risk to the patient during
testing procedures. Aspiration of contaminates can potentially be life-threatening.
Use disposable anti-bacterial filters or disinfect each part in contact with the patient
before each test.
You must follow all the cleaning procedures in System Maintenance, and you must
thoroughly inspect the components after cleaning and before each patient test.
This device is not suitable for use in presence of flammable anaesthetics. It is not
an AP nor an APG device (according to the EN 60 601-1 definitions).
Keep the device away from heat and flame source, flammable or inflammable
liquids or gases and explosive atmospheres.
In accordance with their intended use K4 b2 is not to be handled together with other
medical devices unless it is clearly declared by the manufacturer itself.
It is recommended to use a computer with electromagnetic compatibility CE
marking and with low radiation emission displays.
It is necessary to make the PC, connected to the K4 b2, compliant with EN 60601-1
by means of an isolation transformer.
The K4 b2 needs special precautions regarding EMC and needs to be installed and
put into service according to the EMC information provided in the section EMC.
Portable and mobile RF communications equipment can affect the K4 b2.
Use only the cable and accessories supplied with the equipment. The use of
accessories and/or cables other than those supplied may result in increased
emissions or decreased immunity of the equipment.
The K4 b2 should not be used adjacent to or stacked with other equipment. If
adjacent or stacked use is necessary, the K4 b2 should be observed to verify normal
operation in the configuration in which it will be used.
Graphical symbols used in accordance to present specifications are described here
below:
Equipment type B (EN60601-1)
Equipment type BF (EN60601-1)
Danger: high temperature
OFF
ON
Protective earth ground
Chapter 1 - Getting started - 15

Alternating current
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Contraindication
The physical strain to execute the respiratory manoeuvre is contraindicated in case of
some symptoms or pathology. The following list is not complete and must be
considered as a piece of mere information.

Contraindications for the Spirometer tests
Absolute contraindications

For FVC, VC and MVV tests:
• Post-operating state from thoracic surgery
For FVC tests:
•

Severe instability of the airways (such as a destructive bronchial emphysema)

•

Bronchial non-specific marked hypersensitivity

•

Serious problems for the gas exchange (total or partial respiratory insufficiency)

Relative contraindications

For FVC tests:
•

spontaneous post-pneumothorax state

•

arterial-venous aneurysm

•

strong arterial hypertension

• pregnancy with complications at the 3rd month.
For MVV test:
•

hyperventilation syndrome

Contraindications for Bronchial provocation tests
The bronchial provocation tests must be executed according to the doctor’s discretion.
There are not data that reveal specific contraindication for the bronchial provocation test
through inhalation.
The modern standard processes have been revealing secure in several clinical studies.
However it is recommendable to respect the following contraindications:
Absolute contraindications

•

Serious bronchial obstruction (FEV1 in adults)

•

Recent myocardium infarct

•

Recent vascular-cerebral accident

•

Known arterial aneurysm

•

Incapacity for understanding the provocation test procedures and its implications.

Relative contraindications

•

Bronchial obstruction caused by the respiratory manoeuvre.

•

Moderate or serious bronchial obstruction. For ex. FEV1 < 1.51 in men and FEV1
in women < than 1.21.

•

Recent infection in the superior air tracts

•

During the asthmatic re-acuting

•

Hypertension

•

Pregnancy

•

A pharmacology treatment epilepsy

Contraindications for Exercise testing
Read carefully the exercise testing chapter.
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Environmental condition of use
COSMED units have been conceived for operating in medically utilised rooms without
potential explosion hazards.
The units should not be installed in vicinity of x-ray equipment, motors or transformers
with high installed power rating since electric or magnetic interferences may falsify the
result of measurements or make them impossible. Due to this the vicinity of power lines
is to be avoided as well.
Cosmed equipment are not AP not APG devices (according to EN 60601-1): they are
not suitable for use in presence of flammable anaesthetic mixtures with air, oxygen or
nitrogen protoxide.
If not otherwise stated in the shipping documents, Cosmed equipment have been
conceived for operating under normal environmental temperatures and conditions [IEC
601-1(1988)/EN 60 601-1 (1990)].
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•

Temperature range 10°C (50°F) and 40°C (104°F).

•

Relative humidity range 20% to 80%

•

Atmospheric Pressure range 700 to 1060 mBar

•

Avoid to use it in presence of noxious fumes or dusty environment and near heat
sources.

•

Do not place near heat sources.

•

Cardiopulmonary resuscitation emergency equipment accessible.

•

Adequate floor space to assure access to the patient during exercise testing.

•

Adequate ventilation in the room.

EMC
Guidance and manufacturer’s declaration - electromagnetic emissions
The K4 b2 is intended for use in the electromagnetic environment specified below. The customer
or the user of the K4 b2 should assure that it is used in such an environment.
Emissions test
Compliance
Electromagnetic environment - guidance
RF emissions
Group 1
The K4 b2 uses RF energy only for its internal function.
Therefore, its RF emissions are very low and are not
CISPR 11
likely to cause any interference in nearby electronic
equipment.
RF emissions
Class B
The K4 b2 is suitable for use in all establishments,
including domestic establishments and those directly
CISPR 11
connected to the public low-voltage power supply
Harmonic Emission
Class A
network that supplies buildings used for domestic
IEC 61000-3-2
purposes.
Complies
Voltage Fluctuations /
Flicker Emission
IEC 61000-3-3
Guidance and manufacturer’s declaration - electromagnetic immunity
The K4 b2 is intended for use in the electromagnetic environment specified below. The customer
or the user of the K4 b2 should assure that it is used in such an environment.
Immunity test
Test level
Compliance level
Electromagnetic
environment - guidance
±6 kV contact
±6 kV contact
Electrostatic
Floors should be wood,
discharge (ESD)
concrete or ceramic tile. If
±8 kV air
±8 kV air
floors are covered with
IEC 61000-4-2
synthetic material, the relative
humidity should be at least
30%.
Electrical fast
±2 kV for power
±2 kV for power
Mains power quality should
transient/burst
supply lines
supply lines
be that of a typical
commercial
or
hospital
IEC 61000-4-4
±1 kV for
±1 kV for
environment.
input/output lines
input/output lines
Surge
±1 kV differential ±1 kV differential Mains power quality should
mode
mode
be that of a typical
IEC 61000-4-5
commercial
or
hospital
±2 kV common
±2 kV common
environment.
mode
mode
Voltage dips, short
interruptions
and
voltage variations on
power supply input
lines
IEC 61000-4-11

Power frequency
(50/60 Hz) magnetic
field
IEC 61000-4-8

<5% UT
(>95% dip in UT)
for 0.5 cycles
40% UT
(60% dip in UT) for
5 cycles
70% UT
(30% dip in UT) for
25 cycles
<5% UT
(>95% dip in UT)
for 5 sec
3 A/m

<5% UT
(>95% dip in UT)
for 0.5 cycles
40% UT
(60% dip in UT) for
5 cycles
70% UT
(30% dip in UT) for
25 cycles
<5% UT
(>95% dip in UT)
for 5 sec
3 A/m

Mains power quality should
be that of a typical
commercial
or
hospital
environment. If the user of the
K4 b2 requires continued
operation during power mains
interruptions,
it
is
recommended that the K4 b2
be
powered
from
an
uninterruptible power supply
or a battery.

Power frequency magnetic
fields should be at levels
characteristic of a typical
location
in
a
typical
commercial
or
hospital
environment.
Note: UT is the a.c. mains voltage prior to application of the test level.
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Guidance and manufacturer’s declaration - electromagnetic immunity
The K4 b2 is intended for use in the electromagnetic environment specified below. The customer
or the user of the K4 b2 should assure that it is used in such an environment.
Immunity test
Test level
Compliance
Electromagnetic environment level
guidance
Portable and mobile RF communications
equipment should be used no closer to
any part of the K4 b2, including cables,
than the recommended separation
distance calculated from the equation
applicable to the frequency of the
transmitter
Recommended separation distance

Conducted RF
IEC 61000-4-6

3 Veff
150 kHz to
80 MHz

3V

Radiated RF
IEC 61000-4-3

3 V/m
80 MHz to
2.5 GHz

3 V/m

d=1.17

P

d=1.17

P

80 MHz to 800 MHz

d=2.33 P 800 MHz to 2.5 GHz
where P is the maximum output power
rating of the transmitter in watts (W)
according to the transmitter manufacturer
and d is the recommended separation
distance in metres (m).
Field
strengths
from
fixed
RF
transmitters, as determined by an
electromagnetic site surveya, should be
less than the compliance level in each
frequency rangeb.
Interference may occur in the vicinity of
equipment marked with the following
symbol:

Notes:
(1) At 80 MHz, the higher frequency range applies.
(2) These guidelines may not apply in all situations. Electromagnetic propagation is affected by
absorption and reflection from structures, objects and people.
a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless)
telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV
broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic
environment due to fixed RF transmitters, an electromagnetic site survey should be
considered. If the measured field strength in the location in which the K4 b2 is used exceeds
the applicable RF compliance level above, the K4 b2 should be observed to verify normal
operation. If abnormal performance is observed, additional measures may be necessary, such
as reorienting or relocating the K4 b2.
b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
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Recommended separation distances between portable and mobile RF communications
equipment and the K4 b2
2
The K4 b is intended for use in an environment in which radiated RF disturbances are controlled.
The customer or the user of the K4 b2 can help prevent electromagnetic interference by
maintaining a minimum distance between portable and mobile RF communications equipment
(transmitters) and the K4 b2 as recommended below, according to the maximum output power of
the communications equipment..
Separation distance according to frequency of transmitter
Rated maximum
output power of
(m)
transmitter (W)
80 MHz to 800 MHz
800 MHz to 2.5 GHz
150 kHz to 80 MHz
d=1.17

P

d=1.17

P

d=2.33

P

0.01
0.12
0.12
0.23
0.1
0.37
0.37
0.74
1
1.17
1.17
2.33
10
3.70
3.70
7.38
100
11.70
11.70
23.33
For transmitters rated at a maximum output power not listed above, the recommended separation
distance d in metres (m) can be determined using the equation applicable to the frequency of the
transmitter, where P is the maximum output power rating of the transmitter in watts (W)
according to the transmitter manufacturer.
Notes:
(1) At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.
(2) These guidelines may not apply in all situations. Electromagnetic propagation is affected by
absorption and reflection from structures, objects and people.
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Safety and conformity
Safety

IEC 601-1 (1988) /EN 60 601-1 (1990);
Find reported below the complete classification of the device:
•

Class I type B device

•

Protection against water penetration: IP00, ordinary equipment unprotected against
water penetration

•

Non sterile device

•

Device not suitable in the presence of flammable anaesthetics;

•

Continuous functioning equipment;

EMC

The system meets the EMC Directive 89/336
EN 60601-1-2
EN 55011 Class B (emission), IEC 1000-4-2, IEC 1000-4-3, IEC 1000-4-4
Telemetry

I-ETS 300 220, CEPT T/R 01-04
pr ETS RES 0908 (CE type conformity)
Transmission frequency and output power can be changed upon request according to the
destination country requirements.
Quality Assurance

UNI EN ISO 9001:2000 (Registration n° 387-A Cermet)
UNI EN ISO 13485:2003 (Registration n° 387-M Cermet)
Medical Device Directive (CE mark)

MDD 93/42/EEC (Notified Body 0476).
Class IIa
FCC (only USA version)

FCC ID: SN7-K4B2T-USA (transmitter)
FCC ID: SN7-K4B2R-USA (receiver)
This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may cause
undesired operation.
Changes or modifications not expressly approved by the party responsible for
compliance could void the user’s authority to operate the equipment.
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Keynotes
Here are the keynotes used to make the manual easier to read.

Typographic keynotes
These are the typographic keynotes used in the manual.
Style

Description

Bold
“Italic”

indicates a control or a key to be pressed.
indicates a messages shown by the firmware.

Graphic keynotes
These are the graphic keynotes used in the manual.
Illustration

Description

shows the button to click in the software to activate the related feature.
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System overview
Portable Unit (PU)
It is fixed to the patient during the test by an anatomic
harness. The PU contains the O2 and CO2 analyzers, sampling
pump, UHF transmitter, barometric sensors and electronics. It
is powered by the rechargeable battery fixed to the back side
of the harness.
K4 b² is also provided with a small display, the PU shows in
real time the following parameters: VT, VE, VO2, VCO2, R,
HR, Rf Marker, battery charge level, temperature and
barometric pressure.
USA and Japan versions have the antenna not detachable from
the portable unit.
Besides data processing and presentation, the Portable Unit
has the following functions:
•

Patient data input

•

Environment data input (humidity)

•

Gas and turbine calibration (automatic)

•

Memory functions

•

Tests data management

•

Data loading to a PC (via RS232)

Telemetry Data Transmission, Receiver Unit (RU)

The RU consists of a small unit connected to a PC through the
RS 232 serial port. The transmission is achieved by a
miniaturized transmitter module located inside the Portable
Unit.

Battery Charger Unit (CU)

The CU allows the simultaneously charge of the 3 Ni-Cd
batteries and to supply the PU during the warm up time.
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Flowmeter
The system uses a bi-directional digital turbine. It opposes a very low resistance to flow
(<0,7 cmH2O/l/s to 12 l/s). The air passing through the helical conveyors, takes a spiral
motion which causes the rotation of the turbine rotor. The rolling blade interrupts the
infrared light beamed by the three diodes of the optoelectronic reader. Every
interruption represents 1/6 turn of the rotor, this allows to measure the number of turn in
the time.

Gas analysers
The O2 and CO2 analysers are temperature-controlled and the internal pressure and
expired flow are monitored for an higher reliability if the measurements.
The K4 b² uses Nafion Permapure ® which is a semipermeable capillary tube capable of
removing the humidity in excess without altering the gas concentrations..
The analysers calibration is automatic and shows both graphically and numerically the
flow and concentration signals and the accuracy of the baseline/gain.

PC Software
The PC software, running on Windows™, allows the user to manage data stored in the
Portable Unit or transmitted to PC. Here following a list of the main features available:
•

Test data management.

•

Viewing data in table and graphic form

•

Automatic and manual detection of anaerobic threshold (modified V-slope
method).

•

On-line data presentation during tests.

•

Advanced data elaboration (filtering, smoothing, built in spread-sheet features).

•

O2 Kinetics (O2 deficit, O2 debt and time constant in both rising and falling edge of
a constant load exercise test).

•

Flow-Volume loops during the test and overlapped on the rest FVC.

•

Real time display of the O2 and CO2 waveforms during the test.

•

Control of any ergometer provided with a RS232 interface.

•

Custom fittings (linear and exponential).

•

Spirometry (FVC, VC, IVC, MVV).

•

File exporting in three different formats (Lotus 123™, Excel™, ASCII).

•

Automatic detection of the "Steady State".

•

Adding parameters and predicted equations trough the "Formula Editor" tool-kit.

•

DDE with Microsoft Excel.

•

Customizing software environments (colours, printed parameters...).

•

Help on line.
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Before starting
Before operating the K4 b2 we strongly recommend to check the equipment and register
you as a customer.

Checking the packing contents
Make sure that the package contains the items listed below. In case of missing or
damaged parts, please contact Cosmed technical assistance.



Note:
a: Non telemetric version
b: Internat. telemetric version
c: USA telemetric version
d: Japan telemetric version
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Code
(version)

C00950-01-04
C00952-01-04
C00952-02-04
C00949-01-04
C01599-01-04
C01599-02-04
C00260-01-04
C01570-01-06
C00342-01-12
C02120-01-05
C02200-01-11
A 800 900 001
C02210-01-08
C02910-01-10
C02911-01-10
C02912-01-10
A 661 200 001
A 661 200 002
A 182 320 001
C01460-01-06
A 362 060 001
C01507-01-12
C00659-01-12
A 410 110 002
C02100-01-06
C02100-02-06
C00341-01-12
C01577-01-12
C01929-01-08
C01143-01-98
C01800-01-05
C01509-01-30
C01588-01-20
A 680 023 500
A 680 013 630
A 680 044 500
C01790-01-36
C01999-02-DC
C00067-02-94
C01508-02-91

Qty
a b

c

d

1
1
1
1
1

2
1
2
1
1
1
1
1
1
2
1
1
1
1
3
2
1
1
1
1
1
2
2
1
1
1
1
1

1
1

1
1 1 1
1
1
2 2 2
1 1 1
2 2 2
1 1 1
1 1 1
1 1 1
1 1 1
1 1 1
1 1 1
2 2 2
1 1 1
1 1 1
1 1 1
1 1 1
4 4 4
3 3
3
2 1 1
1 1 1
1 1 1
1 1 1
1 1 1
1 1 1
1 1 1
2 2 2
2 2 2
1 1 1
1 1 1
1 1 1
1 1 1
1 1 1

Description
(see note by side)

K4 b2 Portable Unit
K4 b2 Portable Unit
K4 b2 Portable Unit
K4 b2 Portable Unit
K4 b2 Receiver Unit
K4 b2 Receiver Unit
K4 b2 Battery Charger Unit
Antenna
Antenna cable
Turbine Ø 28mm
Kit optoelectronic reader K4 b2
Head cap for the adult masks
Permapure L73cm
Mask mouth/nose breath adult S
Mask mouth/nose breath adult M
Mask mouth/nose breath adult L
HR elastic belt
HR polar transmitter
Anti moisture filter
RH/TA probe
Power cord Schuko 2m
RS232 cable K4 b2
Cigar light adapter
Battery size AA 1,5V
Battery pack TX K4 b2
Battery pack TX K4 b2
Cable power supply BNCxRF
Cable power supply RX unit
Harness K4 b2 adult
Velcro strips (set 8 pieces)
Kit gas calibration
Carrying case
Holder Portable Unit
Time lag fuses 5x20 250V T500mA
Time lag fuses 5x20 250V T630mA
Fuses 6,3x32 250V F5A
PC software
Conformity declaration
Registration card
K4 b2 User Manual

Warranty registration
Before using the system, please take a moment to fill in the registration form and the
warranty and return them to COSMED, by doing this you are eligible to the customers
assistance service.
For further information, please refer to the enclosed registration and warranty form. If
the form is not enclosed in the packaging, please contact directly COSMED.
Register the product via software

Together with the PC software, a registration software is supplied. With this software it
is possible to fill in an electronic form with the customer information.
1. To run the software, double click on the icon Registration or select Registration…
from ? menu.
2. Type the requested information and click Send… to send the form via e-mail to
COSMED.
How to contact COSMED

For any information you may need, please contact the manufacturer directly at the
following address:
COSMED S.r.l.
Via dei Piani di Monte Savello, 37
P.O. Box n. 3
00040 - Pavona di Albano
Rome - ITALY
Voice: +39 (06) 931.5492
Fax: +39 (06) 931.4580
email: customersupport@cosmed.it
Internet: http: //www.cosmed.it
Complain, feedback and suggestions

If you have any complain, feedback information or suggestion, please inform us at
complain@cosmed.it.
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Options/Accessories
Accessories
Code

Quantity

C02150-01-11
C00600-01-11
C02115-01-10
C02114-01-10
C02113-01-10
A 800 900 004
A 800 900 017
A 800 900 018
A 800 900 019
A 800 900 020
A 800 900 021

1
1
1
1
1
1
1
1
1
1
1

Description

Adapter Spirometry kit x opto-reader 2000
3 liters syringe for flows and volume calibration
Adult face mask with x Turbine 2000
Mask mouth/nose breath ID28 paediatric L
Mask mouth/nose breath ID28 paediatric S
Paediatric Headcap
Comfort seal L 10 pcs
Comfort seal M 10 pcs
Comfort seal S 10 pcs
Comfort seal paediatric L 10 pcs
Comfort seal paediatric S 10 pcs

Options
Telemetry data transmission

The optional Telemetry data transmission allows the researcher to transmit data on line
to a PC up to a distance of 800 meters. All signals are in real time transmitted via radio
to the RU to be saved and displayed on-line to any PC.
Spirometry Kit

Optional software and accessories designed for performing screening Spirometry such
as Forced Vital Capacity, Slow Vital Capacity, Maximum Voluntary Ventilation and
broncho-challenge tests.
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PC configuration required
•

Pentium II 350 MHz.

•

Windows XP, Vista

•

64 Mb RAM .

•

CD drive.

•

VGA, SVGA monitor.

•

Serial Port RS 232 available (2 serial ports in case of Ergometer control). An USB
port can replace one RS232 serial port, if using the USB-RS232 adaptor (Cosmed
code A 388 410 001).

•

Any Mouse and Printer compatible with the MS Windows™ operative system.

•

PC conform to European Directive 89/336 EMC
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Technical features
Portable Unit

Memory
Display LCD
Keyboard:
Serial Port
Power supply:
Thermometer:
Barometer:
Dimensions PU :
Dimensions battery:
Weight:

16,000 breaths
2 lines x 16 characters
waterproof, 6 keys
RS 232C
Ni-MH rechargeable batteries 3 hours endurance
0-50°C
53-106 Kpa
170x55x100 mm,
120x20x80 mm
400g

Receiver Unit

Transmission range:
Battery:
Dimension:
Weight:
PC interface:

800 meters
4 x 1.5 V AA
170 x 48 x 90 mm
550 g
RS 232

Battery charger Unit

Power supply
Power consumption

120V - 240 V
25 W

Flowmeter

Type:
Flow Range:
Accuracy:
Resistance:
Ventilation Range:

Bidirectional digital turbine Ø 28 mm
0,03-20 L/sec
± 2%
<0.7 cmH2O s/L @ 12 L/s
0-300 litres x min

Oxygen Sensor (O2)

Response time:
Range:
Accuracy:

<150 ms
7-24% O2
±0.02% O2

Carbon Dioxide Sensor (CO2)

Response time:
Range:
Accuracy:

<150 ms
0-8%
±0.01%

Humidity absorber

Capillary of Nafion (Permapure ®)
Power Supply

Voltage:
Power consumption

100V-240V ±10%; 50/60Hz
60W

Environmental Sensors

Temperature:
Barometer:
Humidity:
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0-50°C
400-800 mmHg
0-100%

Measurements

Pulmonary function tests and measured parameters
Breath by Breath exercise testing
Symbol

UM

Parameter

VO2
VCO2
Vt
FetO2
FetCO2
R
VE
HR
Qt
AT
VE
SV
RF
FeO2, FeCO2
VE/VO2
VE/VCO2
VO2/HR
VO2/Kg
Ti, Te, Ti/Ttot
Vd/Vt
PaCO2
P(a-et)CO2

ml/min
ml/min
l
%
%
--l/min
1/min
l
--l/min
l/min
1/min
%
----ml/beat
ml/min/Kg
sec
--mmHg
mmHg

Oxygen Uptake
Carbon Dioxide production
Tidal Volume
End Tidal O2
End Tidal CO2
Respiratory Quotient
Ventilation
Heart Rate
Cardiac output
Anaerobic Threshold
Ventilation
Stroke volume
Respiratory Frequency
Averaged expiratory concentration of O2 e CO
ventilatory equivalent for O2
ventilatory equivalent for CO2
Oxygen pulse
VO2 per Kg
time breaths
Vd/Vt ratio
arterial PCO2 (estimated)
Delta PaCO2 – PetCO2

Symbol

UM

Parameter

EE
EE/BSA
EE/Kg
FAT
CHO
PRO
FAT%
CHO%
PRO%
npRQ

Kcal/day
Kcal/day/m2
Kcal/day/Kg
Kcal/day
Kcal/day
Kcal/day
%
%
%
—-

Energy Expenditure
Energy Expenditure/Body surface area
Energy Expenditure pro Kg
Fats
Carbohydrate
Protein
% Fat
% Carbohydrate
% Protein
Respiratory quotient not protein

Symbol

UM

Description

VO2 @ LT

l/m

Lactate (Anaerobic) Threshold

R @ LT
Time @ LT
VCO2

-hh:mm:ss
ml/min

Respiratory Quotient @ LT
Time @ LT
CO2 output @ LT
STPD

VE

l/min

Ventilation @ LT

Indirect Calorimetry

Lactate Threshold (V-Slope)
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BTPS

STPD

HR

bpm

Heart Rate @ LT

Parameter

UM

Calculation

O2 deficit
O2 debt

l/m
l/m

VO2@work*tau
VO2'@work*tau

O2 Kinetics

Spirometry Tests (option)
FVC - Forced Vital Capacity
Symbol

UM

Parameter

FVC
FEV1
FEV1/FVC%
PEF
FEV0.5
FEV6
FEV1/FEV6
FEV6/FVC%
Best FVC
Best FEV1
Best PEF
Vmax25%
Vmax50%
Vmax75%
FEF25-75%
FET100%
FEV2
FEV3
FEV2/FVC%
FEV3/FVC%
FEV1/VC%
FEF50-75%
FEF75-85%
FEF0.2-1.2%
FiVC
FiF25-75%
FiV1
PIF
VEXT
PEFT

l
l
%
l/sec
l
l
%
%
l
l
l/sec
l/sec
l/sec
l/sec
l/sec
sec
l
l
%
%
%
l/sec
l/sec
l/sec
L
l/sec
l/sec
l/sec
ml
msec

Forced Expiratory Vital Capacity
Forced Expiratory Volume in 1 sec
FEV1 as a percentage of FVC
Peak Expiratory Flow
Forced Expiratory Volume in 0.5 sec
Forced Expiratory Volume in 6 sec
FEV1 as a percentage of FEV6
FEV6 as a percentage of FVC
Best Forced Expiratory Vital Capacity
Best Forced Expiratory Volume in 1 sec
Best Peak Expiratory Flow
Expiratory Flow when 75% of the FVC remains to be exhaled
Expiratory Flow when 50% of the FVC remains to be exhaled
Expiratory Flow when 25% of the FVC remains to be exhaled
Mid-exp flow between 25-75%FVC
Forced expiratory time
Forced Expiratory Volume in 2 sec
Forced Expiratory Volume in 3 sec
FEV2 as a percentage of FVC
FEV3 as a percentage of FVC
Tiffenau index
Mid-exp flow between 50-75%FVC
Mid-exp flow between 75-85%FVC
Mid-exp flow between 0.2 l - 1.2 l
Inspiratory Forced Vital Capacity
Forced mid-inspiratory flow
Forced Inspiratory Volume in 1 sec
Peak Inspiratory Flow
Extrapolated Volume (back extrapolation)
Time to PEF (10% - 90%)

VC/IVC - Slow Vital Capacity and Ventilatory pattern
Symbol

UM

Parameter

EVC
IVC
ERV
IRV
IC

l
l
l
l
l

Expiratory Vital Capacity
Inspiratory Vital Capacity
Expiratory Reserve Volume
Inspiratory Reserve Volume
Inspiratory Capacity
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VE
Vt
Rf
Ti
Te
Ttot
Ti/Ttot
Vt/ti

l/min
l
1/min
sec
sec
sec
—l/sec

Expiratory Minute Ventilation
Tidal Volume
Respiratory Frequency
Duration of Inspiration
Duration of Expiration
Duration of Total breathing cycle
Ti/Ttot ratio
Vt/ti ratio

MVV - Maximum Voluntary Ventilation
Symbol

UM

Parameter

MVV
MVt
MRf
MVVt

l/min
l
1/min
sec

Maximum Voluntary Ventilation
Tidal Volume (during MVV)
Maximum Respiratory frequency
MVV duration time

Bronchoprovocation Response
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Symbol

UM

Parameter

FallFEV1
FallVmax50%
P10
P15
P20

%
%
———-

Fall in FEV1 from baseline or post diluent
Fall in Vmax50% from baseline or post diluent
Provocative dose causing FEV1 to fall 10% from baseline
Provocative dose causing FEV1 to fall 15% from baseline
Provocative dose causing FEV1 to fall 20% from baseline

Installation

Installation sequence
Before starting operating with the system make sure to meet the environmental and
operational conditions reported in Chapter 1.

Battery Charger Unit

The Battery Charger Unit allows the following functions:



Warning: Before turning the
Battery Charger Unit on, check
the voltage switch selected
meets your main voltage.

•

Charge 3 rechargeable batteries simultaneously.

•

Charge batteries by means of the car lighter plug.

•

Supply the K4 b2 Portable Unit directly by the main power.

Check voltage

The Battery Charger Unit is provided with a switch that allows to change the voltage
according to the following values:
•

115V 50-60 Hz (100V-120V)

• 220V 50-60 Hz (200V-240V)
To change setting, move the switch on the new voltage by using a small screwdriver or
a pen.
Turn the Unit on

1.
2.

Connect the Charger Unit to the main plug.
Turn on the Unit by pressing the orange power switch.

Charge the batteries

1.
2.

Insert the batteries into the places on the top of the unit as shown in the illustration
below.
The small green LED placed on the front panel warns the charge in progress. The
battery is charged when the light signal placed on the front panel of the Charger
Unit starts blinking.

Note: USA and Japan versions have not the antenna connector on the battery.
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Battery low

It is recommended to charge batteries before each test. When the batteries are low the
warning message is prompted on the PU by two beeps for an half charged battery and
three beeps for a complete discharged battery.
As soon as the message appears, you must change batteries immediately since the
system has only few minutes of endurance still available. The system allows to change
the battery during testing as well.
During the test, it is possible to monitor the battery status in real time by selecting
Information from View menu.

Portable Unit
The PU can be supplied either by the Charger Unit or by rechargeable batteries. It is
recommended during Warm-up to supply it exclusively by the Charger Unit time in
order to save the battery used normally during the test.
The control panel of the Portable Unit is mainly composed by a keyboard, and 4 plugs
for power supply, turbine, antenna, heart frequency and sampling tube connections. The
following illustrations show in detail the control panel.

A
B
C
D
E
F

Marker key
Display
Cancel key
Enter key
Scroll up/down key
On/Off switch

Note: USA and Japan versions have the antenna not detachable from the portable unit.
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Important: In order to ensure
accurate gas measurements,
you must wait for a warming-up
time before operating the K4
b². During this period the PU
must be turned on for at least
45 minutes.



Warning: Supply K4 b2 with
Charger Unit for warming up
only.

Warm up

The K4 b2 uses O2 and CO2 heated sensors. We strongly recommend at least 45 minutes
warm-up time at an ambient temperature of 20°C. More time is necessary if the
environmental temperature is lower. Calibration or testing before warm-up time is
completed, can cause wrong results.
Warming-up the unit by main power

1.
2.

Connect the Charger Unit to the main power by the AC power cable.
Connect the power-supply cable both in the Charger Unit and K4 b2 as shown
below and turn both the units on.

Turning on/off the portable unit

To turn the K4 b2 on or off press the on/off key.
Connect the rechargeable battery

Plug the power supply cable into the battery socket as shown in the following
illustration.

International telemetric version

USA and Japan Telemetric version

Sometimes you might need to change the battery during the test. To do this you must
change the battery in the shorter time possible. The Portable Unit does not transmit data
while it is not powered.
Warning: During testing make sure to change the battery as fast as possible, since a
long time could compromise the reliability of measurements.
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Receiver Unit
Optionally the K4 b2 is provided with a transmitter board (located inside the K4 b2 unit)
and a Receiver Unit to monitor "on-line" exercise tests performed either in the field or
in the lab. All data measured by the K4 b2 are transmitted "breath by breath" to the
Receiver Unit in real time. The RU (illustrated below) must be connected to a Personal
Computer with any RS 232 serial port to display data "on-line" in the management
software. The transmission range is 800 meters in open field. However during
transmission the test is stored in the memory of the K4 b2 Unit so that, in case of
transmission interference no data is lost.

Turning on/off the receiver unit

To turn the receiver unit on or off use the switch on the front side of the unit.
Receiver unit power supply

The K4 b2 Receiver Unit is provided with four 1.5 V AA batteries. Before turning the
unit on be sure that batteries are charged. If the status battery indicator blinks red you
must replace the 4 batteries. The unit can be also supplied by 6V DC power through the
cable provided in the equipment.
The receiver unit can be supplied by two different sources:
•

by the Battery Charger Unit: connect the units by the 6V DC cable.

•

by 4 AA 1,5V batteries.

Calibration Gas Cylinder
In order to calibrate the sensors you need to have available calibration cylinder with the
following gas concentration:
Cylinder

Recommended Gas mixture

Calibration
O2 16%, CO2 5%, N2 Balance
For the calibration procedure, see the Calibration chapter.
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Connecting the K4 b2 to the patient
K4 b2 is a portable system with a total weight lower than 1 kg. Cosmed has developed a
special harness to fix the unit to any subject. The harness consists of a belt that can be
adjusted to fit different sizes and positions. I.e. if you need to test cyclist or rower
athletes we recommend to locate both units (K4 b2 and battery) on the back of the
subject to increase comfort and to avoid any obstacles during movements. For this
reasons plates are provided with the harness and they can be easily removed and placed
in different positions.

Assemble the mask and the flowmeter
K4 b² is provided with a turbine flowmeter that can be easily disassembled for allowing
cleaning and disinfection.
1. Plug the turbine in the mask adapter by pushing and rotating it clock-wise till you
feel a stop.
2. Insert the optoelectronic reader over the turbine and press it till the mask.
3. Plug the wind cover as described in point 1.
4. Plug the sampling tube in the little hole located in the optoelectronic-electronic
reader.
5. Plug the turbine cable in the Turbine plug control panel of the K4 b2.



Notice: In order to preserve
items composing the mask, it's
recommended to grease
periodically O-rings in the
optoelectronic reader with
Silicone compound grease.

Using the "Ultimate Seal"
The "ultimate seal" is a moulded of Elasto-Gel, a glycerine based hydrogel. This
product is a unique polymer gel that forms an intimate seal between the face and the
mask. It has to be used for mask applications on hard to seal faces and where leaks are
not tolerated.
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•

Will not irritate the skin

•

Contains no adhesives.

•

Has no odour

•

Will not dry out

•

Single patient use

Apply the seal to the mask

Apply seal to clean, residue-free mask only and follow the instructions below:
1. Remove the plastic tray from the bag. Peel off clear film and retain for later use.
2. While holding tray align the nose area of mask to nose area of Ultimate Seal™ gel.
Press together and roll mask down over the surface of the gel seal attaching it to the
mask and releasing it from the tray.
3. If needed, adjust the position of the seal, aligning it with the outer perimeter of the
mask sealing surface.
4. The mask is now ready to be placed on the subject's face.
To remove seal on mask



Notice: Avoid the exposure
to the sun. Do not put the
seal into the water.

•

The Ultimate Seal™ have been conceived for a single patient use only, it can not be
cleaned or sterilised.

•

If mask requires cleaning for a new patient application then pull off and dispose of
the Ultimate Seal™.

•

To keep the seal clean between use, keep it attached to the mask and place the clear
film against the Ultimate Seal™ gel on the mask. When the seal becomes
discoloured or opaque (approximately two weeks) dispose of the current seal and
replace it with a new one.

Assembling the flowmeter for spirometry tests
In case the spirometry kit option is purchased assemble the turbine as shown in the
illustration below.
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Fixing the K4 b2 to the patient
1.
2.
3.

4.
5.
6.
7.

Fix the heart belt to the patient’s box thorax.
Fix the K4 b2 unit to the front of the harness. Do the same operation with the battery
on the back .
Connect the battery cable to the 6V plug of the K4 b2 control panel. Be sure that the
red plug, that repairs the plug from water or sweat drops, is on the Portable Unit
side.
Connect the antenna cable to the Antenna plug of Portable Unit control panel.
Insert the heart frequency receiver and temperature probe cable in the HR-Temp
plug placed on the control panel.
Insert the male connector of the turbine in the Turbine plug on the control panel.
Fix the power supply cables, antenna and turbine on the right side of the jacket with
the velcro stripes provided in the equipment. Fix the heart frequency probe on the
left side.



Notice: Be sure to fix the
Heart rate probe on the left
side, while the other cables
have to be fixed on the right
side. This must be done for
avoiding interferences
between cables.



Notice: Fix all cables with
the velcro strips provided
with the equipment.

Note: USA and Japan versions differ from the picture because of the antenna
placement.
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Connecting the K4 b2 to the PC
K4 b2 can be connected to any PC provided with serial port in order to monitor "online" physiological data during any kind of activity.

Connect the Portable Unit to the PC
Connect the K4 b2 Portable Unit to a serial port available in the PC. Be sure to set the
K4 b2 software to the proper serial port for the transmission.

Connect the Receiver Unit to the PC
Connect the telemetry module to a serial port available in the PC. Be sure to set the K4
b2 software to the proper serial port for the transmission.
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Software installation
Note: The software can be installed on Windows XP or Vista It will not work on any
previous versions of Windows.
The software consists of two programs: a spirometry program (uses a green CD,
labelled PFT, option) and the program for ergometry (uses a blue CD, labelled CPET).
The programs share the same archive and system calibration program.
One or both software programs may need to be installed depending on the device
configuration.

Installing the software
Note: The software is copyright protected and should be installed only
original disk.
1.
2.
3.
4.

from the

Insert the installation CD into the CD-ROM drive.
The installation will begin automatically. If the disc does not start automatically
you will need to run Setup.exe.
Follow the instructions given by the dialog boxes to complete the installation.
When the installation is finished, the program will alert you that the installation has
been successfully completed.

Note: If both programs are installed, the directory for the CPET software should be the
same as the PFT directory (default is C:\PFTSUITE).

Run the software
1.
2.

In the Windows Start menu, open the Program Group in which the software was
installed.
Click the CPET or the PFTSuite icon.

PC port configuration
The first time the software is used, it is necessary to configure the communication port
with the PC (USB, COM1, COM2,…).
For further details, see the chapter Database management.
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Software main features
Display
The program may contain several windows. The active window is highlighted with a
different colour of the caption. Some functions of the program are "active window"
sensitive (Print, right key of the mouse).

Tool bar
Many of the functions that may be selected from the menu can be activated more
rapidly by clicking with the mouse on the corresponding icon in the tool bar.
Positioning the mouse cursor on one of the buttons of the toolbar (if the option Hints is
enabled), the description of the corresponding function is shown in a label.
Show/hide the toolbar

Select Toolbar from Options menu in order to show or hide the toolbar.

Dialog windows
The typical operating environment of Microsoft Windows is the Dialog box. This
window is provided with a series of fields in which input the information.
Use of the keyboard

•

To move the cursor among fields, press the Tab key until you reach the desired
field.

•

Press the Enter key to confirm the information input on the dialog box or press the
Esc key to cancel changes.

Use of the mouse

•

To move the cursor among fields, move the mouse on the desired field and leftclick.

•

Click on the OK button with the Left button of the mouse to confirm the
information input on the dialog box or click on Cancel button to cancel changes.

Scroll bars
Some windows are provided with scroll bars that help to see data exceeding the window
space available.
•

To move the scroll bar row by row click the scroll arrows at the end of the scroll
bars

•

To move the scroll bar page by page click on the grey area at both sides of the
scroll fields

On line help
COSMED K4 b2 Help is a complete on-line reference tool that you can use at any time.
Help is especially useful when you need information quickly or when the user manual is
not available. Help contains a description of each command and dialog box, and
explains many procedures for accomplishing common tasks.
To get the Help on line, press the F1 key.

Software version
To know the software version and the serial number of the software, select About…
from ? menu.
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Calibration

Gas calibration procedures
The system can be calibrated according to the following procedures:
1. Room air calibration
2. Reference gas calibration
3. Delay calibration
4. Turbine calibration
The Room air calibration, forced by the system before every test, consists of a sampling
room air. It updates the baseline of the CO2 analyzer and the gain of the O2 analyzer, in
order to match the readings with the predicted athmospheric values (20.93% for O2 and
0.03% for CO2).
The Reference gas calibration, recommended to be carried out daily, consists of
sampling a gas with a known composition (i.e. 16.00% for O2 and 5.00% for CO2) from
a calibration cylinder, and updating the baseline and the gain (span) of the analyzers in
order to match the readings with the predicted values (i.e. 16.00% for O2 and 5.00% for
CO2).
The Delay calibration, recommended to be carried out ones a week or whenever the
sampling line is replaced, is necessary to measure accurately the time necessary for the
gas sample to pass through the sampling line before being analyzed.
The Turbine calibration, recommended to be carried out quarterly, consists in measuring
the volume of a 3 litres calibration syringe and in updating the gain of the flowmeter in
order to match the predicted value.

Running the Calibration program
Start the program and choose Calibration from the Test Menu. The software runs the
Calibration software and the main menu changes accordingly.

Log file
The program creates and updates as default the calibration log file, containing the
conditions and the results of all the calibrations performed by the user.
To access the file select File/Report File... from the calibration program.

Setting reference values
Before starting calibrating make sure that the system has been configured correctly by
setting the right values of gas concentration of: room air (i.e. 20.95% O2 and 0.03%
CO2), of gas mixture contained in the cylinders and the volume of the calibration
syringe (i.e. 3 litres).
Set the reference values using the PC software

This operation must be performed only the first time. The next times, the system keeps
stored the reference values entered in this step.
1. Select Reference Values from the Calibration menu.
2. Type the correct values for the O2 and CO2 room air concentration (i.e. 2093 for
20.93%), and do the same for the gas concentration of the calibration cylinder.

3.
4.
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Type the volume of the calibration syringe (i.e. 3000 for a 3 litres calibration
syringe).
Press OK button to confirm changes.

Set the reference values using the Portable Unit

To set reference values from the K4 b2 Portable Unit go to the main menu, choose
Calibration and scroll tasks up to choose Set Cal. Predicted Values, type the values
using the arrow keys and press Enter to confirm changes.

Room air calibration


Note: After turning on the
unit, wait 45 minutes warm
up time before starting the
calibration procedure.

Room Air calibration is forced to be performed before each test. With this procedure the
system calibrates both gas analyzers according to the Room Air Concentrations
(20.95% O2 and 0.03% for CO2). You can run this procedure either with the software or
directly with the Portable Unit.
Room air calibration using the PC software



Important: During
calibration always remove
the sampling tube from the
optoelectronic reader. Do
not remove the sampling
tube from the Portable Unit
otherwise calibration could
be affected.

1.
2.
3.

4.

Connect the Portable Unit to the PC by the serial port. Remove the sampling plug
from the flowmeter.
Run the calibration program and choose Room air from the Calibration menu.
The message "Room air calibration in progress..." will appear and a graph will
show in real time the O2 and CO2 calibration. At the end of the manoeuvre the
message "Calibration done" will be visualized.
The following dialogue box will appear showing the calibration results, press OK
to confirm the calibration.



Caution: During Room Air
calibration be sure to put the
sampling line far from the
expired gas otherwise
calibration could be affected.



Caution: Room Air calibration
performed in small ambients
(high concentration of CO2)
affects the calibration results
and the accuracy of the
following test.

Room air calibration using the Portable Unit

1.
2.

Remove the sampling plug from the flowmeter.
In the main menu choose Calibration menu, choose Room Air Calibration and
confirm by pressing Enter.

3.

The procedure is automatically performed until the message "Calibration done"
appears, the O2 and CO2 values will be visualized on the display.

4.

Exit the Calibration menu by pressing Enter or Cancel.
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Reference gas calibration


Notice: Do not use mixtures
with a O2 concentration above
24% since it is out of the
oxygen sensor range

The software allows to automatically calibrate zero, gain and alignments of the gases
sensors. Even if the program doesn't force you to carry out the calibration, the system
should be calibrated before each test. To perform the sensor calibration is necessary to
have available a cylinder filled of a concentration known of mixed gas. It is suggested
to use CO2 5,00% , O2 16% concentrations and N2 for balance.
The calibration unit



Notice: Before calibrating be
sure the "Reference values"
of room air and reference
gas are properly entered.



Caution: Be sure that the
cylinder pressure out is
regulated to 3 and 5 bar.

The gas regulator has an adjustable second stage that must be open every time the
cylinder is used for the calibration. This is necessary to avoid a small leakage in the
connections can discharge the bottle in few time.
1. Make sure you wait for warm-up time before starting calibrating. Be sure the highpressure tube supplied together with the system is connected to the "Cylinder" plug.
2. Open the cylinder valve by turning the valve counter-clockwise, the pressure value
must be set within a range of 300-500 Kpa (3-5 bars or 44-73 Psi).



Notice: If the pressure
regulator is set at a different
pressure from what
specified, room air could be
mixed together with
reference gas and the
calibration could be affected.

After these operation, please operate as follows.
Reference gas calibration using the PC software



Notice: Before calibrating be
sure the "Reference values"
of room air and reference
gas are properly entered.

1.
2.

3.
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Connect the K4 b2 unit to the PC by the serial port. Remove the sampling plug from
the optoelectronic reader.
Run the calibration program and choose Gas from the Calibration menu.

The message "Gas calibration in progress..." will appear and a graph will show in
real time the O2 and CO2 calibration. The software runs first the Room Air

calibration, so do not connect the sample plug to the calibration kit until the
message "Sample reference gas..." will be displayed. At the end of the procedure
the message "Calibration done" will be visualized.

4.
5.

The dialogue box showing the calibration results will appear, press OK to confirm
the calibration.
Remove the sampling line from the kit and close the cylinder.

Reference gas calibration using the Portable Unit

1.
2.

Remove the sampling plug from the flowmeter.
In the main menu choose Calibration menu, choose Refernce gas calibration and
confirm by pressing Enter.

3.

The K4 b2 runs first the Room Air calibration, so do not connect the sample plug to
cylinder output until the message " Sample reference gas..." will be displayed. At
the end of the procedure the message "Calibration done" will be visualized.
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4.
5.

Exit the Calibration menu by pressing Enter or Cancel.
Remove the sampling line from the kit and close the cylinder.

Gas delay calibration
The delay calibration procedure is a calibration included in the software due the time
alignment between flow and gas concentration measurements is one of the potential
problems to consider to assure accurate readings during test. The gas delay calibration is
the measurement of time required by the gas to reach the gas analyzer.
For "breath by breath" analysis it is essential that the instantaneous flow rate must be
multiplied by the proper time-matched expired gas concentration. Although flow can be
instantaneously measured, gas concentration measurements can be calculated with a
delay related both to the time necessary for the gas to be transported to the sensor and to
intrinsic characteristics of the analyzer principle.
Two factors contribute to the time alignments delay. K4 b2 uses a capillary sampling
tube with a pump to draw a continuous gas sample into the analyzers. The gas transport
time depends on the dimensions of the tube and on the pump flow rate. Additionally the
gas sensors have a response time that must be added to the above delay for calculating
the total delay.
The software of the K4 b2 by carrying out the Gas Delay procedure calculates this delay
and introduces a correction to realign both flow and gas measurements.
This procedure must be carried out each time some changes occur in the sampling
system, i.e. when the sampling tube is changed. However it is recommended to carry
out this calibration each week in order to prevent wrongs measurements.
Delay calibration using the PC software

1.
2.
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Connect the K4 b2 unit to the PC by the serial port. Remove the sampling plug from
the optoelectronic reader.
Run the calibration program and choose Delay from the Calibration menu.

3.

The message "Gas calibration in progress..." will appear and a graph will show in
real time the O2 and CO2 calibration. The software first runs the Room Air
calibration. At the end of the Room Air calibration the following message appears.

4.

Connect the sampling tube to the optoelectronic reader and press OK button to start
breathing at a constant rate.
Synchronise the breath (inspiration and exhalation) with the acoustic signal..
Continue breathing some cycles until the message "Calibration done" appears. The
software open a dialogue box with the new calibration factors and the new delay
value. Press OK to confirm the calibration.

5.
6.

Delay calibration using the Portable Unit

1.
2.
3.

4.

5.

On the main menu scroll the commands, choose Calibration and press Enter to
confirm the choice.
Choose O2/CO2 delay calibration and press Enter to confirm.
The following message appears, and the software automatically run the Room air
Calibration.

When the message “Connect the sampling line and press Enter” appears press
Enter and start breathing at a constant rate. Synchronise the breath (inspiration and
exhalation) with the acoustic signal.
After some cycles a message will appear confirming the delay calibration and the
new values will be shown on the display. Press Cancel to return to the previous
menu.

Print the calibration report
In the Calibration program choose Print from the File menu.

Edit the calibration factors
The last sensors calibration factors can be either edited or viewed. To do this choose
Gas Results… from the File menu.
To view or edit the last Turbine calibration factor choose Turbine results… from the
File menu.
Note: To restore factory setting press Default button in the dialog box. Once you press
the default button you must run a new calibration before testing.

Chapter 4 - Calibration - 53

Turbine calibration
The system uses a turbine flowmeter. It opposes a very low resistance to flow (<0,7
cmH2O/l/s to 12 l/s). The air passing through the helical conveyors, takes a spiral
motion which causes the rotation of the turbine rotor.
The rolling blade interrupts the infrared light beamed by the three diodes of the
optoelectronic reader. Every interruption represents 1/6 turn of the rotor, this allows to
measure the number of turn in the time. There is a constant ratio between air passing
through the turbine and number of turns. This allows an accurate measure of flows and
volume. The turbine flowmeter doesn't need daily calibrations as it is not affected by
pressure, humidity and temperature.
To work properly, the turbine only requires the rotor to rotate freely without any friction
that might be caused by dust that can be easily avoided with an ordinary cleaning
procedure (see Maintenance).
However in order to ensure accuracy it's recommended to run periodically the
calibration procedure. Calibration has to be carried out with a calibration syringe of 3
litres volume, the calibration procedure is totally managed by software.
A measurement system should be calibrated daily in order to ensure maximum accuracy
and reliable test results. If a correct maintenance is provided it’s possible to check the
calibration of the turbine flowmeter even at relatively long intervals (i.e. 1 month). The
calibration procedure assures valid and verifiable results within a ±3% accuracy.
The calibration syringe

The 3 litres calibrated syringe is included in all the Quark PFT line with the exclusion
of the PFT 1 model.
3 litres calibration syringe: P/N C00600-01-11.

Turbine calibration for ergospirometry tests
Before starting the calibration procedure, be sure that the turbine type is properly
selected.
Please select on the portable unit 1.Settings/8.Turbine 18/28 and set Turbine 28.
If the calibration is performed through the PC, in the calibration program, select
File/Turbine results..., in the field Type (mm) must be entered 28.

Assembling the flowmeter

1.
2.
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Connect the Opto-reader to the calibration syringe through the adapter.
Connect the flowmeter to the syringe with the rubber cylinder supplied in the
standard packaging.

1. Syringe
2. Silicone tube
3. Adaptor for calibration syringe.
Note: If a bacterial filter is used for the tests, do use it also during the turbine
calibration.
Calibrating the turbine



Note: If you are using a slow
PC, we recommend to set
an higher refresh time.

Turbine calibration using the PC software
After having run the calibration program:
1. Select Reference Values from the File menu. If your syringe has a different value
from the default one (3 litres), please enter the correct value.
2. Select Calibration/Turbine….
3. When the Calibration Turbine dialog box appears with the syringe piston initially
pushed all the way in, move the piston in and out for 5 inspiratory strokes and 5
expiratory strokes in order to get the first values appearing on the display. Then
move the syringe piston for other 10 strokes (IN and EX).

4.
5.

At each of the 10 steps the software displays the results of the manoeuvre and the
percentage error in the reading.
At the end of this operation, the software displays the new calibration factors. Press
OK to store the new value.
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Turbine calibration using the Portable Unit
1. Screw up the adapter for the calibration syringe to the optoelectronic reader.
2. Connect the optoelectronic reader to the calibration syringe. Before starting the
calibration be sure to have inserted the right reference value for the syringe. To
check it, select Volume Syringe from the Set predicted value menu.

3.
4.
5.

Then choose Calibration from the main menu and press Enter.
Scroll the menu, choose Turbine Calibration and press Enter.
Start moving the syringe till the message "Operate syringe" will disappear on the
display. The display will show expired (E) and inspired (I) readings for each stroke.

6.

When the display visualizes the message "Calibration done" the Turbine has been
calibrated, press Cancel to return to the main menu, the new calibration factor will
be automatically stored.

Turbine calibration for the RMR test
The turbine used for resting metabolic rate tests is different from the standard one (used
for ergo-spirometric tests). Since the correction factors for the two turbines are different,
before using this turbine, it is necessary to select and calibrate the turbine used.
Please select on the portable unit 1.Settings/8.Turbine 18/28 and set Turbine 18.
If the calibration is performed through the PC, in the calibration program, select
File/Turbine results..., and enter 18 in the field Type (mm).

At the end of the RMR tests, before starting using the standard turbine, set 28 in the
Type(mm) field and perform a turbine calibration with the standard turbine.
Assembling the flowmeter
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Connect the RMR reader to the syringe by means of the proper adaptor.
Calibrate the turbine

Perform a turbine calibration according to the procedure described above. Since the
ventilation is very low (normally <10 litres/min), the turbine calibration has to be
performed with very slow manoeuvres (each complete manoeuvre in about 10-15
seconds), to obtain the best accuracy.

Chapter 4 - Calibration - 57

Checking the system signals
The control panel
The Control Panel, which can be activated from the Calibration/Control panel…
menu item, is a useful tool to check the main hardware functions of K4 b2.
By using the controls on Control Panel you are able to do the following:
1. Reading the signals acquired by the system both as voltages and processed data;
2. Activating/Disactivating the valves, the sampling pump and other installed
components (for example, oxymeter).

Using the control panel

mV / real values
display

Flowmeter
on/off

edit parameters
(name, unit,…)
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Buzzer
on/off

Sampling
pump on/off

Transmitter
on/off

Select all
channels

Deselect all
channels

Digital CO2
trimmer

Signal refresh
time

Operating modes

K4 b2 Operating modes
K4 b2 is a versatile system. You can use it in the field or in the lab without any kind of
limitation. Test can be carried out in the following three different configuration:
•

Holter Data Recorder

•

Telemetry Data Transmission

•

Laboratory Station

Holter Data Recorder
Using the system in the field without the Receiver unit you can store data "breath by
breath" in high capacity memory (1 MB). The memory allows to store up to 16
thousands breaths, when the test is completed, the results can be downloaded to the PC
via the RS 232 port provided with the equipment.

Telemetry Data Transmission (option)
In case the telemetry Data Transmission module is available, the K4 b2 portable unit
provided with a small transmitter that allows to send data by telemetry up to a distance
of 800 meters. All data are transmitted "breath by breath" to the receiver unit. The
Receiver Unit must be connected to a PC by serial port, it allows the resercher to
monitor data on line both in table and graphic format. Anyway tests are stored in the
memory of the portable unit, thus in case of transmission interferences no data are lost.
By using the system with a PC the software K4 b2 can also control and synchronise
ergometers by using user defined exercise protocol.

Serial (Laboratory) Station
Although K4 b2 has been designed for tests in the field, it can also be used as a
conventional laboratory station as it offers the same features of the best stand alone
devices. Under this operating mode the K4 b2 Portable Unit is simply connected to the
PC through the RS232 serial port and all tasks, exactly like any conventional laboratory
device. Anyway tests are stored on the memory of the portable unit as well.
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Portable Unit User Interface diagram

Settings

Memory
functions

Test

Calibration

On/Off
Transmitter

Memory
Status

Patient’s
Data

Room Air
Calibration

Enable/Disable
Warnings

View
Test list

Start
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Reference Gas
Calibration

Set Date and
Time

Erase
Memory

Turbine
Calibration
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Settings
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External
Device

Control
Panel

Turbine
18/28

GPS
Autolocate

Altitude
Setting

Version
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Holter Data Recorder Mode
It is ideal operating modes if you need to test a patient difficult to monitor by Telemetry
(i.e. climbing, long distances races, etc). The memory capacity of the K4 b2 is able to
store data up to 16 thousands breaths. The system saves data for each breath, hence time
storing capacity depends on the respiratory frequency.

1.
2.
3.
4.
5.
6.
7.



Note: USA and Japan
versions have the items 3
and 5 slightly different
because of the antenna
placement.

Mask + flowmeter
Heart rate belt
Rechargeable battery
Harness
K4 b2 Unit
HR probe
Power cable

Operating sequence
Warming-up the system

Warm-up the K4 b2 for 45 minutes before testing or calibrating.
Enter new patient

1.
2.

Connect K4 b2 to the subject.
Go to the K4 b2 control panel and choose Patient's data from Test menu.

3.

Move the cursor among fields with the Enter key and use the Up and Down keys
to modify values.

4.

The fields are shown in the following order:
#:
patient ID
A: age in years
H: height (cm or inch)
W: weight (kg or Lbs)
S:
sex (M or F)
HR: HR max
The HR Max is automatically calculated by the formula 220-age, however it can be
also changed according to physician experience and patient medical history. By
confirming the HR rate value all the patient data are automatically saved.

Calibrate and start the test

1.
2.
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Remove the sampling plug from the mask and put the tube far from expired gas
concentrations.
On the Patient's Data menu scroll down the menu and select Start Test from the
main menu and press Enter to confirm.

3.

The message "Insert relative humidity" will be visualized, type the correct value
and press Enter.

4.

The K4 b2 runs automatically the Room Air calibration. The message "Do not
breath near the sampling line" appears. Wait for few seconds until the message
"Calibration done" will appear together with a double beep sound.

5.

Connect the sampling plug to the optoelectronic reader. Some values (Heart Rate,
R, VO2, VCO2,...) will be shown and updated each breath on the control panel
display. The message "Press Enter to start the test" will be displayed each 10 secs.
You can switch to different values by moving the Up and Down key.
After having pressed the Enter key the test starts but the K4b2 is not storing data.
In this phase the PU is checking the main parameters and you can visualize it on the
PU display by the time is blinking.

6.

7.

To start storing data press another time the Enter key. You can check the storing
phase because the time parameter don't blink anymore.

Stop the test

To stop the test press Cancel. The message "Press enter to stop test" will appear, press
Enter to stop the test.
Transferring test to PC

Once the test is concluded you may download all data stored in the K4 b2 to the
management software.
1. Turn the K4 b2 on.
2. Connect the K4 b2 to the PC by the serial cable enclosed in the equipment.
3. Run the K4 b2 software and choose Receive Test from the Test menu.

4.

5.

To download a test you must link it to an existing patient file. Choose Find and
then List to select an existing patient. If the patient is new than select Find and then
New, fill in the fields and press OK to confirm.
Select the test to link by using First, Previous, Next and Last buttons and press
Download to confirm your choice and to store the test on the Hard Disk. You can
use the Preview button to see some data and graph of the test in order to find out
the proper one.
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Telemetry Data Transmission Mode
Note: USA and Japan
versions have the items 3
and 5 slightly different
because of the antenna
placement.

In case you need to monitor in real time the test you can use the Telemetry Data
Transmission module that is provided by COSMED as an option. The transmission
range can reach 800 m allowing to monitor exercise testing in the field. To use this
option you need a personal computer to connect the receiver unit.

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Mask + flowmeter
Heart rate belt
Rechargeable battery + antenna
Harness
K4 b2 Unit
HR probe
Power cable + antenna
Receiver unit
RS232 cable
Personal computer

Operating sequence
Warming-up the system

Warm-up the K4 b2 for 45 minutes before testing or calibrating.
Connect the receiver unit to the PC

Connect the receiver unit to PC with the serial cable provided in the standard packaging.
Enable transmission

1.
2.

Go to the K4 b2 control panel, verify that transmission is enabled by choosing
Settings /On/Off Transmitter and press Enter.
Enable the transmission by moving the "*" sign on Transmit. On and press Enter
to confirm settings.

Enter new patient

1.
2.

Connect K4 b2 to the subject.
Go to the K4 b2 control panel and choose Patient's data from Test menu.

3.

Move the cursor among fields with the Enter key and use the Up and Down keys
to modify values.

The fields are shown in the following order:
#:
patient ID
A: age in years
H: height (cm or inch)
W: weight (kg or Lbs)
S:
sex (M or F)
HR: HR max
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4.

The HR Max is automatically calculated by the formula 220-age, however it can be
also changed according to physician experience and patient medical history. By
confirming the HR rate value all the patient data are automatically saved.

Enable reception on PC

1.
2.
3.

4.
5.

6.

Run K4 b2 software.
Open patient data dialog box, select or type a new name and press OK to confirm.
The name of the selected patient will appear in the status bar of the software.
Choose Execute test from the Test menu.

Type the patient information, select a protocol from the list and an ergometer if
you are going to carry out a test with an ergometer.
Chose Other Data if you want to insert other important informationon the the you
are going to perform.

Select the workspace you would like to see during the test (it can be also changed
during test), check the option box Telemetry to enable software receiving of data
and press OK to confirm. The software will show blank windows waiting for the
first breath.

Calibrate and start the test

1.
2.
3.

4.

Remove the sampling plug from the mask and put the tube far from expired gas
concentrations.
On the Patient's Data menu scroll down the menu and select Start Test from the
main menu and press Enter to confirm..
The message "Insert relative humidity" will be visualized, type the correct value
and press Enter.

The K4 b2 runs automatically the Room Air calibration. The message "Do not
breath near the sampling line" appears. Wait for few seconds until the message
"Calibration done" will appear together with a double beep sound.
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5.

6.

7.

Connect the sampling plug to the optoelectronic reader. Some values (Heart Rate,
R, VO2, VCO2,...) will be shown and updated each breath on the control panel
display. The message "Press Enter to start the test" will be displayed each 10 secs.
You can switch to different values by moving the Up and Down key.
After having pressed the Enter key the test starts but the K4b2 is not storing data.
In this phase the PU is checking the main parameters and you can visualize it on the
PU display by the time is blinking.

To start storing data press another time the Enter key. You can check the storing
phase because the time parameter don't blink anymore.

Stop the test

To stop the test press Cancel. The message "Press enter to stop test" will appear, press
Enter to stop the test.
Transferring test to PC

If some interferences should occur during test execution by telemetry, some breaths
could be lost. The software shows a message on the status bar warning that some steps
missed . Since K4 b2 stores every time the complete test in the memory, it is possible to
download the test later to the management software to recover all lost data.
1. Turn the K4 b2 on.
2. Connect the K4 b2 to the PC by the serial cable enclosed in the equipment.
3. Run the K4 b2 software and choose Receive Test from the Test menu.

4.

5.
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To download a test you must link it to an existing patient file. Choose Find and
then List to select an existing patient. If the patient is new than select Find and then
New, fill in the fields and press OK to confirm.
Select the test to link by using First, Previous, Next and Last buttons and press
Download to confirm your choice and to store the test on the Hard Disk. You can
use the Preview button to see some data and graph of the test in order to find out
the proper one.

Serial Mode
Note: USA and Japan
versions have the items 3
and 5 slightly different
because of the antenna
placement.

When the K4 b2 is used in the serial mode the system works exactly as any other
conventional laboratory station. In this mode the software controls completely the K4 b2
portable unit so that any command such as calibration can be run by the software. You
can also drive an ergometer if a second serial port is available in the PC.

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Mask + flowmeter
Heart rate belt
Rechargeable battery
Harness
K4 b2 Unit
HR probe
Power cable
Receiver unit
RS232 cable
Personal computer

Operating sequence
Warming-up the system

Warm-up the K4 b2 for 45 minutes before testing or calibrating.
Connect the Portable unit to the PC

1.
2.
3.

Connect K4 b2 to the PC by the serial cable
Check that the Serial Port is properly selected by choosing RS 232 from the Option
menu.
Check the Ergometer connected to PC option box if you intend to use an
ergometer for testing.

Calibrate the system

1.
2.

Run the K4 b2 software and choose Calibration from the Test menu.
In the Calibration software select Analyzers -> Room Air from the Calibration
menu.

Enter patient data

1.

In the K4 b2 software and choose Patient from the File menu.

2.

Select a patient from the list or press New to enter a new name and press OK to
confirm.
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Start the test

1.

2.

3.
4.

5.

6.

Open patient data dialogue box, select or type a new name and press OK to
confirm. The name of the selected patient will appear in the status bar of the
software.
Choose Execute test from the Test menu.

Type the patient information, select a protocol from the list and an ergometer if
you are going to carry out a test with an ergometer.
Chose Other Data if you want to insert other important informationon the the you
are going to perform.

Select the workspace you would like to see during the test (it can be also changed
during test) and be sure that option box Telemetry is disabled since the
transmission will be done by serial cable. Press OK button to start acquisition.
The software displays the data according to the selected workspace. Check some
breaths and press F2 to start testing.

Stop the test

To end the test press F3, press OK in the following dialogue box to confirm the end of
the test. All data will be automatically saved on the Hard disk. Anyway test is stored on
the memory of the portable unit as well.
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Database
Management

Exercise testing patient's database
The exercise testing software uses a different interface for presenting patient
information. The patient database allows to:
•

Enter a new patient

•

Find patient data

•

Edit patient data

• Delete patient data.
Select Patients from the File menu.

Enter a new patient
1.
2.

Press New to show the Patient dialog box.
Enter data of a new patient and press OK button to confirm.

Find a patient
Enter a search string into the Find field and press Find to view the data concerning a
subject already in the database. You can search for “Last name”, “ID code” or
“Progressive”.
Or:
Press List to view the list of patients in the database. Press Next or Previous to view
the data corresponding to the next or to the last patient. Press OK to confirm.
The Next and Previous buttons allow to move to the next or the previous patient in the
database.

Edit patient data
1.
2.
3.

Select the patient.
Press Modify… in order to edit the patient’s data.
Edit the desired values and press OK to confirm.

1.
2.

Select the patient to be deleted.
Press Delete.

Delete a patient
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Uploading tests from the Portable Unit
In telemetry and holter function you could need to upload data from the portable unit
via serial port.
1. Link up the PU to the PC with the RS232 cable supplied.
2. Turn on the Portable Unit.
3. Choose Receive Test from Test menu or press Alt F2.

4.

5.
6.

To be downloaded the test must be linked to a patient. If the current patient has
already been inserted in the database, choose Find and then List select the patient
and confirm. If the current patient doesn't belong to the archive he must be inserted,
select Find and then New, fill in the fields and confirm. Now the download
function is available and the test will be filed on the PC.
Choose the test to link with the First, Previous, Next and Last buttons and press
Download.
A status bar will show the data acquisition in progress. At the end a message will
indicate the end of data reception.
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Archive maintenance
The software allows to manage files selecting Archive from the File menu.
It is advisable to perform the archive reorganisation every month, in order to free space
on the hard disk and/or to correct possible errors present within the database.
It is possible also that your have no more hard disk space. So, you have to delete all the
data. In this case, it is useful to perform the initialising.

Reorganise the archive
1.
2.

Select Reorganize archive from the File menu.
Wait for the end of the operation before performing any other function.

1.
2.

Select Initialize Archive from the File menu.
Wait for the end of the operation before performing any other function.

Delete the archive

Delete a test
To delete an ergometry test, select Test/Delete test.
To delete a spirometry test, press the proper button in the Test Card.

Backup and restore
It is strongly recommended to backup files, a warning message will be displayed
monthly. This function allows the user to restore the data if the PC or the HD will not
work anymore.
Backup

1.
2.
3.

Select Backup archive from the File menu.
Selecting the destination path with the Browse key or press New to create a new
directory. Press OK to confirm.
In the dialog box it will appear an estimate of the number of floppy disks you need
in order to back up the archives. Press OK.

Restore

1.
2.
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Select Restore archive from the File menu.
On the Restore dialog box specify the drive source and press OK, a dialog box
will appear indicating all data of the backup processed.

Spirometry patient's database
The Patients database consists of a Patient Card, a Visit Card and a Test Card in which
are listed all tests performed by the patient.
Select Archive Navigator from the File menu or press the button by side.

Patient Card

It collects all the information of a patient (first name, last name, date of birth) which
remain the same for each visit. For each patient there is only one Patient Card, which is
created the first time the Patient performs a test.
To move within the database use the following buttons:
Move to the first patient in the archive
Move to the previous patient in the archive
Note: after having deleted a
record (patient, visit or test),
it is recommended to
reorganize the archive in
order to free disk space.

Move to the next patient in the archive
Move to the last patient in the archive
Find a patient in the archive
Enter a new patient in the archive
Delete current patient from the archive
Edit the current patient card
Visit Card

It collects all information relative to the visit (diagnosis, visit description...) and to the
patient information subject to change between one visit and another (height, weight,
smoke). Each patient can be related to several Visit Cards provided they have been
created in different days. Before carrying out any spirometric test it is necessary to
create a new Visit Card or to open the today’s Visit Card.
To move within the database use the following buttons:
Move to the first visit in the archive
Move to the previous visit in the archive
Move to the next visit in the archive
Move to the last visit in the archive
Find a visit in the archive
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Enter a new visit card in the archive
Delete current visit card from the archive
Edit the current visit card
Test Card

It contains all the information about the test.
To move within the database use the following buttons:
Delete current test from the archive.
Edit the current test

Import/export a Tests card
This function allows to import /export a test card with the respective visit and patient
card.
1. Select the patient.
2. Choose the test and press the key by side. All data will be imported/exported in the
XPO file format (Cosmed proprietary).

Diagnosis Database
The program allows to manage a diagnosis database, whose records are composed by a
diagnosis ID code and a string of text.
The report of the visits can be done either by typing the desired text in the field
“Diagnosis” of the Visit Card or, more quickly, retrieving from the diagnosis database
the desired one.
If you want to insert, modify or delete a diagnosis from the database select Database
Diagnosis... from the File menu.
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Spirometry program settings
The software allows to configure some options selecting Configure from the Option
menu.

Graphs

All the graphs visualised and/or printed can be customised in colours and appearance.
1. Select the desired colours of the curves (5 curves max can be overlapped on the
same graph).
2. Enable or disable the Grid option.
3. Enable or disable the Show Info Test option.
Serial port

You must select the serial port RS 232 that will be used to connect the Quark b2 with the
PC.
To select the serial port, click on the proper COM button (the selected port must be
different from the mouse one).
Units of measurements

It is possible to configure the units of measurements, weight and height, for printing and
viewing.
To select the units of measurement click on cm/Kg or in/lb according to the desired
format.
Using extra fields

The Patient’s database is organised in 3 different cards (Patient card, Visit Card and
Test card.) where it is possible to store the information about patients and visits .
Besides the standard information, it is possible to customise some fields (user free
fields), entering and labelling measurements coming from other devices.
The customisable free fields are:
•

3 fields in the Patient Card (Patient’s information)

•

3 fields in the Visit Card (information about the visits)

•

3 fields (2 numeric) in the Test card information about Test)

Customise the fields

In the group User free fields type the desired text in the 9 fields available.
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Exercise testing

Recommendations for the exercise testing
The evaluation of the cardiorespiratory function
The physical training requires the interaction of physiological mechanisms that allow
the cardiovascular and respiratory systems to supply the increasing demand of energy
due to the contraction of the muscles.
During the training the systems are both engaged, an adequate answer to the effort is the
measure of theirs health state.
The increase of the metabolic rate, during the exercise, needs an appropriate increase of
oxygen in the muscles. At the same time, the CO2 muscles production must be removed
in order to avoid the lactic acid making.
To satisfy the increase in the gas exchange, necessary to the muscles during the
exercise, is requested the intervention of many physiological mechanisms. This process
involves lungs, the pulmonary circulation, the heart and the peripheral circulation.

Precautions
The physician has the responsibility that the patient subjects to the test is a suitable
person able to execute an effort test.
Laboratory

The room, in which the test is performed, must be big enough to contain the whole
necessary equipment, allowing an easier accessibility to the patient in case of
emergency.
In the room should be placed a thermometer and a hygrometer; the heart frequency and
the perceived values of the effort rise as much as the ambient temperature increases, and
the variability of the cardiovascular response grows for humidity values higher of 60%.
Generally it is considered 22°C the temperature adequate for the test execution, even for
short efforts, values till 26°C can be considered acceptable in presence of an efficient air
ventilation.
Ending the test

The patient should be monitored with ECG for at least 8 minutes, in resting conditions
or until he returns to the pre-exercise conditions.

Preparing the patient
To enhance the value of a diagnostic test it’s very important patient collaboration. In
most cases a well-informed patient will make a better effort (in relation to his
conditions) and will allow a reliable interpretation of the test. For this reason every
ergometric test must be preceded from a precise training of the patient.
Before testing

The physician applying the exam must be provided with a written request including a
brief description of the diagnosis (confirmed or suspected ), the request’s reason and the
patient therapy carried out showing the dose and time of the drug assumption.
To standardise the response to the test and reduce the patient’s anxiety it’s suggested to
provide him either written (before the exam) or oral (at the same time of the test)
information. At the scheduling time detailed instructions should be delivered to the
patient, consisting in smoke and food abstinence three hours before an ergometric test,
or eight hours before a scintigraphic test.
Test are usually executed supporting the therapeutic outline in progress, but sometimes
it could be necessary to stop some drugs, such as b-block or calcium antagonist, which
could impair the effort response reducing the diagnostic accuracy of the exam.
The patient must wear comfortable suit and gymnastic shoes and two hours before test
stop any kind of drugs, eat light and avoid coffee and smoke.
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It’s very important acquire information on the patient’s clinical past before performing
the test. Keep attention in particular way to the use of drugs, tobacco, to the physical
fitness and symptoms produced with the exercise.
Patient assent

The patient is informed that he will be submitted to a maximum effort, which could be
stopped at any moment, and of the risks of the test execution.
Ending the test

Test may end when the maximum value of the oxygen consumption has been reached
and the patient’s response established.
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Real time test
Before starting exercise test type a new patient information or choose one from the list
of patient in the file. As soon as a patient has been entered the software is ready to start
a test. The name of the active patient is shown on the status bar of the program window.
Start a test

Start the test as described in the chapter Operating modes. If you use the device in
Holter mode, please skip this until Data management. The following is applicable only
to tests performed with the PC (telemetry or serial mode).
The software environment will change showing a new Menu bar and toolbar while the
first data will be displayed in a table format.

At this point the software starts showing data on the monitor but without saving them,
this in order to monitor the patient before starting the test. To start storing data press F2.
Abort the test without saving data

Choose Abort from the Test menu or press Alt+F3.
End the test saving data

1.
2.

Choose End from the Test menu or press F3.
Choose Yes to end the test or No to continue.

View data in real-time
The visualisation features and capabilities of the data and graphs are identical to the
ones described in the Data management chapter. Starting the test a small window will
appear on the right corner displaying time, bmp and, if selected before, the ergo
protocol and trainer.

View graphs in real-time

1.
2.

Choose Graph from the View menu.
Follow the instructions described in data management section to edit the graphs.

Parameters to view
While the test is running, it is possible to choose the parameters to view.
1. Select Parameters to view/Test execution… from the Options menu.
2. Select the parameters and confirm.

80 - K4 b2 User Manual

Manual protocol
If you are using the K4 b2 with a treadmill without serial interface, it is possible to enter
manually from the PC the event, the phase and the marker.
Enter Load and Phase
Tip: pressing the Shift key
while choosing the marker
option will allow you to enter
the label for that marker.

1.
2.

During the test select Load from the Events menu.
Select the phase and/or type the value of the load and press OK to confirm.

Set the markers

Select Marker from the Events menu.

Automatic protocol
The software allows to automatically control the ergometer according to the protocol
previously selected. Anyway it is allowed to change it even after the test is started.
Modify the load during the test

1.
2.

During the test choose Ergometric protocol from the Events menu.
Select the row corresponding to the desired load and press OK to confirm.

Set the BPM alarm
The software allows the user to set the alarm level for the heart rate, in order to monitor
the patient response.
Enter the BPM

1. Choose BPM alarm from the Events menu.
2. Set the alarm by moving the scroll bar and press OK to confirm.
It also allows to enable or disable the acoustic alarm by the option "Acoustic alarm".
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Data management
As soon as the test has been completed or downloaded, all data stored can be retrieved
for a complete management.

Viewing data
Data can be viewed in the following formats:
Table form
numeric values of the various parameters (columns) corresponding to
each step (rows).
Graphic form
graphical presentation on Y1, Y2, X charts.
Summary
results of the test and statistical analysis of the blocks.
Predicted
predicted values, maximum value measured.
View data in table form

1.
2.

Select Data… from the View menu.
Select the test to visualise in the list box and press OK

Note: Double-click in the
window to open the edit test.

Creating graphs
The software is provided with powerful functions for creating charts. You can add
custom graphs to create exactly what you need.
View data in graph form

1.
2.
3.

Choose Graph… from the View menu.
Select the tests to visualise from the list and press OK
Choose the parameters you require on the X, Y1 and eventually for Y2; select if
necessary some of the following options by pressing the more button and press OK
to confirm.
It is possible to access quickly 5 common graphs from the View/Graph… dialog box.
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Note: Double-click in the graph
window to open the edit test

Right-clicking, the graph can be exported in bmp file format.
Customise the graphs

1.
2.

With a graph on the screen, choose Customise graph from the View menu.
On the Customise graph dialog box, select options to obtain the wished graph.

Option

Function

Grid on X, Y axes

show the grid lines in correspondence with x or y axes that
make the graph easier for you to analyse data.
maximum and minimum values of the graph will be measured
automatically.
points with 0 value measured won't be shown.
make the graph scattered.
highlight with a symbol all steps of the test in which the marker
button was pressed.
makes the graph a square
exclude from the graph all points of the recovery phase.
marks each point with a symbol
allows to set manually the axes values.
Set the axes' scale step.

Autoscale
Ignore 0
Not interpolated
Marker
Squared
Without recovery
Mark points
Min. Max.
Step

Switch from graph to data and vice versa

When the active window is a graph (or a report in data form), it is possible to view very
quickly the data (or the graph) corresponding to that test.
Choose Current test data (if the active window is a graph) or Current test graph…
(if the active window is a data report) from the View menu.
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Viewing predicted values
For some parameter it is possible to compare the maximum value measured during the
test with its predicted value and the LT value both in percentage and absolute.
View predicted values

Choose Predicted from the View menu.

Anaerobic (Lactate) Threshold detection
The software allows to detect the Lactate Threshold (Anaerobic Threshold) according to
the "Modified V-slope method" reference. The LT can be detected both manually and
automatically.
View the Lactate Threshold

Choose Lactate Threshold from the View menu.
Detect the Lactate Threshold

1.
2.
3.

4.

Choose Calculate LT from the Test menu.
For calculating it automatically on the "Lactate Threshold" dialog box click on the
Auto detect button.
For adjusting manually the point you want to detect, move the scroll bar on the
dialog box by pressing the arrow buttons. Data and graph of the LT will be
automatically redrawn.
Press Ok button to save your choices.

Note: Double-click in the
window to open the
corresponding dialog box.

Customise graphs for the LT viewing

The software allows to customise two of the three graphs for the LT visualisation.
1. Choose Lactate Threshold from the Options menu.
2. Choose the parameters you want to be shown on the LT window and press OK to
confirm your choices.
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Fittings
The purpose of the fitting function is to find the function that fits as better as possible
the measured data.
The software allows to fit data according to 3 different functions:
Model

Function

Algorithm

Available for

Linear
Y=A*X+B
Least squares
Any Y vs any X graph
Mono-Exp Y=A+B*exp[(t-t0)/tau] Levemberg Marquardt Any Y vs Time Graph
Mean value
This function is available only if the active window is a single Y graph (i.e. VO2 vs time
or VO2 vs Load).

Fit a graph with a linear regression

1.
2.
3.
4.
5.
6.

Make active the graph window (any Y vs any X graph).
Right-click and select Fitting.
Choose Linear in the type combo box
Select the first point (X1) moving the mouse on the desired place in the graph
pressing the Left key or using the + and – keys.
Select the second point (X2) moving the mouse on the desired place in the graph
pressing the Right key or using the + and – keys.
Press OK to confirm.

Fit a graph with a Mono-exponential regression

1.
2.
3.
4.
5.
6.

7.

Make active the graph window (any Y vs any X graph).
Right-click and select Fitting.
Choose Mono-exponential in the type combo box
Select the first point (X1) moving the mouse on the desired place in the graph
pressing the Left key or using the + and – keys.
Select the second point (X2) moving the mouse on the desired place in the graph
pressing the Right key or using the + and – keys.
Enter (if necessary) the initial values of A, B and TAU (these are the values from
which the iterative algorithm starts in order to reach the best values; the closer are
the initial coefficients to the best ones the higher is the possibility to reach the best
fit).
Press OK to confirm.
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Calculate the "Mean Value"

1.
2.
3.
4.
5.
6.

Make active the graph window (any Y vs any X graph).
Right-click and select Fitting.
Choose Mean value in the type combo box
Select the first point (X1) moving the mouse on the desired place in the graph
pressing the Left key or using the + and – keys.
Select the second point (X2) moving the mouse on the desired place in the graph
pressing the Right key or using the + and – keys.
Press OK to confirm.

Note: The results of the O2 Fittings function are not stored therefore, in order to keep
the information, print the page using File/print Active Window.

Oxygen Kinetic
This function is available only if the active window is a VO2 vs time graph and it has a
sense only with Constant Load Exercise Tests.
The aim of this function is to find the dynamic response of the rising and falling edges
of the VO2 together with the Oxygen Deficit and Oxygen Debt.

Run the O2 Kinetic function

1.
2.
3.
4.
5.
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Make active a VO2 vs Time graph window.
Press the right key of the mouse and select O2 Kinetic.
Select the beginning of the exercise phase (t1) moving the mouse on the desired
place in the graph pressing the Left key or using the + and - keys.
Select the beginning of the exercise phase (t2) moving the mouse on the desired
place in the graph pressing the Right key or using the + and - keys.
Enter (if necessary) the initial values for A, B and Tau (these are the values from
which the iterative algorithm starts in order to reach the best values; the closer are
the initial coefficients to the best ones the higher is the possibility to reach the best
fit) and press OK. You can lock data checking the relative field

Information about the Test
The Test Information dialog box shows all the information concerning environmental
data, patient data and some data about the test
View the Information

Choose Information from the View menu.

Modify the information

1. Press the Modify button on the Information dialog box.
2. Change the values you want to modify and press OK to confirm.
The software allows to assess the energy expenditure and metabolism substratum. In
order to measure FAT and CHO, type the UN (Ureic Nitrogen) value into the field. All
the nutritional parameter will be recalculate considering the UN value.

Summary
The summary feature allows to summarise test results according to the workload and
phase during the test.
View the summary

1.
2.

Choose Summary from the View menu.
The summary of the current test (active window) will be displayed.

Tip: double-clicking on the
Summary window the
function Options/Summary
is activated by which you
may configure the structure
of the data.

Print the data
It is possible to print graphs and data by means of two functions: Print report and
Print current window. The last one is active only if the active window is a graph or a
data report.
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Print the current window

1.
2.
3.

Be sure that the current active window is the graph or the report you desire to print.
Select Print current window from File menu.
Press OK to print, or Setup to customise the print.

Print the report

1.
2.
3.

Select the report to be printed from File menu.
Press OK to print, or Setup to customise the print.
To only view the report, without printing it, press Shift during the selection.

View the report
This function allows to show a preview of a selected report.
1. Select Report from the View menu.
2. Select the test and the report to visualise and press OK to confirm.
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Data Editing
The software allows the user to edit the data acquired during the test in the following
ways:
Nota: In Data view, doubleclick in the window to enter
in “Data Editing”.

•

deleting one or more steps

•

editing row data

•

input new parameters

•

data filtering (averaging or smoothing)

• advanced data elaboration
After data elaboration it is always possible to restore the original data file by pressing
the Restore button .
If you want to save permanently all the changes, press Overwrite; being aware this
function replaces the original test definitely.
Editing values and input numerical values

1.
2.

Choose Edit test from the Test menu.
Select the cell containing the value you want to replace with others values and press
OK to confirm the editing.
The software will recompute all the parameters. Both the tables and the graphs will be
automatically updated.

Data filtering

1.
2.
3.

4.

Choose Edit test from the Test menu.
Press the button Filtering and choose the option Discard invalid steps to
automatically eliminate all the invalid steps
Press the button Filtering and choose the option Averaging and type the desired
value for points Ave/smooth to perform an averaging of the all acquired steps. This
feature reduces the size of the original test.
Press the button Filtering, select the option Smoothing and type the desired value
for points. This feature doesn't reduce the size of the original test, although it
smoothes the fluctuation of data.
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Using the User fields

The software is provided with three free fields in which the user may enter values
coming from others devices such as lactate, blood pressure etc.
To define the user fields:
1. Choose User Fields from the Options menu
2. Type the desired text in the input fields and press OK.
To enter values in the user fields:
1. Choose Edit test from the Test menu.
2. Scroll horizontally until the fields USER 1, 2 and 3.
3. Enter the desired values and press OK to confirm.
Deleting steps

This feature is useful whenever some steps acquired during the test are to be discarded
(steps acquired before the start of the test, patient disconnected from the face mask....).
1. Choose Edit tests from the Test menu.
2. Position the cursor on the step you want to delete and press the button Delete step.
Advanced Editing

This feature allows to perform some advanced editing of the data stored in the software.
1. Choose Edit test from the Test menu.
2. Press the Advanced button and select from the following options:

Option

Function

Delete steps
Smoothing
Edit parameter

deletes the steps meeting the selection criteria
applies a moving average to the selected parameter
edits a parameter according to the selected criteria

Edit parameter

Specifications

Value
Correction %

replaces the value of the selected parameter with a new one.
applies a percentage correction to the value of the selected
parameter.
adds an offset to the value of the selected parameter.
replaces the value of the selected parameter with a
mathematical function.

Offset
Formula...
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Time range

Specifications

From, To
All steps

specifies the time range.
applies the editing from the beginning to the end of the test.

Apply to

Specifications

Parameter
>, >=, =, <, <=, <>

specifies the reference parameter
higher than, higher or equal, equal to, lower than, lower or
equal, different
specifies the value (mathematical expression) compared
with the value of the specified parameter.
do not use any selection criteria.

Value/Formula…
All steps
Restore the original test

To cancel all the editing, in the "Edit Test" dialog box press the Restore button, confirm
your choice by pressing yes.
Overwrite the original test

To save all the editing, replacing the original test with the modified one, in the "Edit
Test" dialog box press the Overwrite button, confirm your choice by pressing yes.

Customise the desktop
Customise the display colours

1.
2.
3.

Select Colors from Options menu.
Select the item to be modified.
Press Change and select the desired colour.

Smart edit
This function is useful to correct data from artefacts; the noise affecting the measured
data can be reduced in 2 different ways:
Graphical noise suppression
using the mouse
Threshold noise suppression
applying a filter to the measured data

Apply the graphical noise suppression

1.
2.
3.
4.
5.
6.

Make active a graph or a data window corresponding to the test that you want to
modify.
Press the right key of the mouse and select Smart Edit.
Select the parameter that you want to modify.
Point the mouse on the position where the graph presents the artefacts, click the
Right key and, keeping pressed the key, drag the point on the desired place.
If you want to cancel the edit press the Left key of the mouse.
Repeat the above mentioned procedure for the all parameters and press OK.

Apply the threshold noise suppression

1.
2.
3.
4.
5.
6.

Make active a graph or data window corresponding to the test that you want to
modify.
Press the Right key of the mouse and select Smart Edit.
Select the parameter that you want to modify.
Set a Noise(%) Threshold (as a percentage of the parameter value) above which
any peak will be considered an artefact.
Press Execute and eventually Undo if you are not satisfied.
Press OK to confirm.
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Customise the parameters
The software allows the user to create customised parameters and predicted values,
derived from the standard parameters (the ones that are calculated by default) through
any mathematical formula.
All the customised parameters can be used freely for viewing and printing purposes.

Create a new parameter

1.
2.
3.

4.

Choose Customise parameters from the Options menu.
Press the New button if you want to create a new parameter or Modify if you want
to modify an existing one
Type the desired value in the fields "Name", "unit of meas", "integers", "decimals"
and "summary" (to present the parameter in the summary) and press the Formula
button.
Insert the mathematical formula by using the appropriate tools and press OK twice
to confirm.

Create a new predicted parameter
1. Choose Customise predicted from the Options menu
2. Press the New button if you want to create a new parameter or Modify if you
intend to modify an existing one
3. Type the desired value in the fields "Name", "unit of meas", "integers", "decimals".
4. Select the group of the predicted values from the options boxes.
5. Select the reference parameter in the "Compared to" list box.
6. Press the buttons in the calculation group and insert the mathematical formulas for
men and women, adults and paediatrics. Press OK twice to confirm.
Once you create the new predicted you can see it in the predicted window.
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Exporting data
With this function you can export the tests data and parameters in different file formats:
•

*.xpo (Cosmed proprietary file format)

•

*.txt (ASCII)

•

*.xls (Microsoft Excel)

•

*.wk1 (Lotus 123)

Export a test

1.
2.
3.

4.

Choose Export Tests from the Test menu.
Select the test to export from the list box and press OK to confirm.
Select the file output format from the list box, click on *.xpo, *.txt, *.xls or *. wk1.
If you selected ASCII format, by clicking on Text button you can then select the
Thousands sep. and Column sep. according to the program you want to use. With
the xpo Cosmed format you can import/export the tests performed on another K4
b2 equipment.
Select the folder, type the file name and press OK to confirm.

Note: The DDE function is
available only if the user PC DDE with Excel
has Microsoft Excel
If Microsoft Excel
installed.

is installed on your PC, you can export a test simply pressing a
button on the toolbar.
To send a test to Excel, select Send to Excel from the Test menu.
The program will show a status bar indicating the data transmission to Excel. At the end
of the process a new sheet with all test data will be opened ready to be edited with the
powerful functions of Microsoft Excel.
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Creating Test Protocols
The software allows to create different exercise protocols to use during the test. The
load of the ergometer is automatically controlled by the software that change it
according to the defined protocol.
Create a new protocol

1.
2.
3.
4.
5.
6.
7.
8.
9.
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Choose Real Time > Ergom. Tests Protocols from the Options menu.
Press New and enter a name for the protocol.
In the field "Message Time" type a number that means to get a message to advise
when switching to the next load.
Enable the "Drive Ergometer" check box to let the software control the ergometer.
Select the "Initial Command" if the ergometer need it.
Enabling the option "Relative Increments", the loads refer to the previous step.
Press Generate and enter the values to generate a protocol from only one load (i.e.
30 Watt each minute for a total of 20 steps) and press OK to confirm.
Press Add if you want to add a new step.
To edit a step, select it from the list and change the relative values in the Edit boxes
below the list. Press the Tab button to save changes.
To delete a step, highlight the step and press Delete.

Software configuration
The software can be customised as you wish. Most of the feature are easily editable to
be tailored according to different purposes.

Data viewing
The software allows to calculate a huge number of parameters; it is advisable, in order
to simplify the analysis of the results, view in the data window the only desired
parameters.
Select the parameters to view

1.
2.
3.

Choose Parameters to view/Test visualisation… from the Options menu.
Select the parameters you require to view.
Press OK to confirm the selected configuration.

Select the parameters to view during the test

1.
2.
3.

Choose Parameters to view/Test execution… from the Options menu.
Select the parameters you require to view.
Press OK to confirm the selected configuration.

Sort the parameters

It is possible to sort the parameters (both for viewing and printing purposes) according
to the desired order.
1. Select Sorting parameters from the Options menu.
2. Move the parameters in the order you want by pressing and holding the left mouse
button.
3. Press OK to maintain the current configuration.

Steady State
The program has an algorithm to tag sets of steps as Steady State.
The algorithm considers belonging to the Steady State the only consecutive steps that
meet the following conditions:
•

The value of VO2, VE and R do not vary from their mean values more than
Threshold (%);

•

The number of consecutive steps that met the preceding criteria are at least
Minimum number of steps.

Customise the Steady State detection criteria

1.
2.

Choose Steady State from the Options menu
Type the desired values for Minimum number of steps, VO2 threshold (%), VE
threshold (%) and R threshold.
The steps which satisfy these conditions will be highlighted with a yellow bar.
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Printout reports
The software allows the user to printout data and graphics according to 4 customisable
reports. Further it allows the user to customise a printout header that will be printed in
each page.
Set up the printout

1.
2.
3.

Choose Reports from the Options menu.
Define the desired features of the report and confirm. Enabling the option "Graphs
in one page" all the graphs selected in the report will be printed in one page.
Type the name you want apply to the report and press OK to save changes.

Select parameters to be printed

K4 b2 allows to print a large number of parameters; it is advisable, in order to simplify
the analysis of the results, to printout desired parameters only.
1. In the report configuration window select Parameters.
2. Select the parameters you require to be printed in the data printout. The number of
parameters which can be printed depends upon the size of the paper in use (see
Printer Layout) and from the orientation of the sheet.
3. Press OK to confirm the selected configuration.
Customise the printout header

1.
2.
3.
4.

96 - K4 b2 User Manual

Choose Printout header from the Options menu.
On the "Report Header" dialog box type the text of the header.
To insert an image click the Logo button. An image editor will be opened, draw the
own logo and close the image editor to save changes.
Press OK to save the Printout header.

Electronic reports (*.pdf)

If an Adobe PDF writer “Printer Driver” is installed and set as the default printer, it is
possible to store the printout report automatically in any location of the HD or
eventually LAN paths according to a customizable filename format.
It is possible to define the created filename format selecting Options/Printout
header..., and then Name format…

Print the current window
The print current window function is enabled when the active window is a graph or a
data report.
1. Select Print current window from File menu.
2. Press OK to print, or Setup to customise the print.

Print the customised report
This function is enabled only after having customised a report.
1. Select the customised report from File menu.
3. Set the sheet format and press OK.
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Events management during exercise testing
By using K4 b2 in serial mode, beside standard measurements, the software allows also
to save some extra "events". They are so called "events" since they are not continuously
stored during the test but they can be saved upon user selection.

Flow Volume loops
This test is useful during exercise to detect abnormalities in the mechanics of ventilation
in patients with pulmonary/ventilatory limitations to exercise.
The test consists in acquiring some flow/volume loops during exercise at different
workloads and overlapping them on the rest maximal flow/volume loop of a Forced
Vital Capacity test.
The majors information that you can get from this manoeuvres are the flow reserve
(flow distance from the peak flow of the F/V loop during exercise to the corresponding
flow on the superimposed F/V loop at rest) and the volume reserve (volume distance
from the maximum volume of the F/V loop during exercise to the corresponding
volume on the superimposed F/V loop at rest).
The manoeuvre consists in the following phases:
•

Acquiring some Flow/Volume loops during the exercise

•

Making the patient inspire completely up to TLC level (this is necessary to place
the loop correctly into the rest F\V loop of the forced Vital Capacity test)

•

Overlapping the F/V loop acquired during exercise and the F/V loop performed at
rest.

Flow Volume loop during the test

1.
2.
3.

Start with normal Exercise test and begin the memorisation of breath values (F2)
During a steady state select F/V loops form Test/Event...
As soon as 2 or 3 complete loops have been acquired ask the patient to inspire
completely up to TLC level and press F3 to stop the acquisition.

O2, CO2 vs Time
The O2, CO2 event is useful to check the real-time readings of the O2 and CO2 signals
during the test.
O2, CO2 vs Time during the test

1.
2.
3.
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Start with normal Exercise test and begin the memorisation of breath values (F2)
During a steady state select O2, CO2 vs Time from Test/Event...
As soon as 5 or 6 complete breaths have been acquired press F3 to stop the
acquisition.

O2 Saturation (optional)
The O2 Saturation event is useful to check the quality of SpO2 signal acquired by the onboard Oxymeter (if available) during the test.
O2 Saturation during the test

1.
2.
3.

Start with normal Exercise test and begin the memorisation of breath values (F2).
Select O2 Saturation from Test/Event...
As soon as 5 or 6 complete pulses have been acquired press F3 to stop the
acquisition.

Spirogram
The spirogram event allows to display and store the volume/time plot.

Spirogram during the test

1.
2.
3.

Start with normal Exercise test and begin the memorisation of breath values (F2).
During a steady state select Spirogram form Test/Event...
Acquire volume/time plot until the window is filled and press F3 to stop the
acquisition.

View the events after the test
1.
2.

Select Data... from the View menu
Select the test during which spirogram event has been carried out in the list box and
press OK
3. Select View... from the Events menu, choose the desired event and press OK.
4. Select Print Current Window... from the File menu to print the F/V curve page.
It is possible to edit the F/V loops event in the following way:
5. Select Edit... from the Event menu to change the F/V loop at rest (the list contains
all the FVC test carried out by the same Patient with the Spirometry software) and
press OK.
It is possible to edit the Cardiac Output event in the following way:
5. Select Edit... from the Event menu to change the parameters measured during the
steady state before the rebreathing, the CO2 concentration at the equilibrium and the
calculation method.

Raw data
It's a particular feature with which the user can check and save some parameters (CO2
output, O2 concentration and volumes) in Ascii file format in a archive apart at a
sampling rate of 25 Hz.
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Save Raw data

1.
2.
3.
4.
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During the test choose Event from Events menu.
Select Raw Data from the list.
On the save data box give a name to the file and select the destination folder.
To stop saving Raw data press the stop icon or press F3 on the keyboard.

Resting Metabolic
Rate Test

Metabolism
Metabolism can be understood as the conversion by the human body between food and
accumulated fat into energy. The energy is used by the body to maintain constant
temperature , to move and to make all the organ function. Measure of metabolism is:
calories (cal).

Total Metabolic Rate
The total metabolic rate are the total calories that the human body needs in order to
actuate the daily functional activities.

Resting Metabolic Rate (RMR)
Resting Metabolic Rate represents the calories that the vital organs need to properly
operate at rest ( heart , brain , lungs , liver , kidneys etc.) . RMR represents between 60
% and 75 % of the human ‘s total metabolism.

Importance to measure RMR
A knowledge of the RMR is very helpful in order to understand the nutritional needs
and to properly manage it.

Measure of the rest metabolic rate with indirect calorimetry
Energy expenditure can be measured directly by putting a person in a calorimeter and
measuring the amount of heat produced by the body mass.
This is expensive and very impractical in the clinical setting. Energy expenditure can be
measured indirectly with a metabolic cart by analysis of respired gases (usually expired)
to derive volume of air passing through the lungs, the amount of oxygen extracted from
it (i.e., oxygen uptake VO2) and the amount of carbon dioxide, as a by-product of
metabolism, expelled to atmosphere (CO2 output – VCO2). With these measurements
the resting energy expenditure (RMR) and respiratory quotient (RQ) can be calculated.
The RQ represents the ratio of carbon dioxide exhaled to the amount of oxygen
consumed by the individual. RQ is useful in interpreting the results of the RMR. The
abbreviated Weir equation is probably the most common calculation of RMR.
Abbreviated Weir equation:
RMR = [3.9 (VO2) + 1.1 (VCO2)] 1.44

How to perform a RMR test
For best results, when having a REE done, there are certain conditions that need to be
controlled and others that just require documenting at the time of the test. During the
test the individual is interfaced with a metabolic measurement system by means of a
facemask.
A mouthpiece with a nose clip is also sometimes used, but it may create overly stressful
conditions to a subject (patient).
Important considerations or conditions to improve the RMR measurement:
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•

No food for at least 12 hours and no smoke for at least 2 hours before the test.

•

Maintain quiet surroundings when the test is in progress and normal temperature.
The individual should not move arms or legs during the test.

•

Medications taken should be noted, such as stimulants or depressants.

•

The first 5 minutes of acquisition should be discarded by the computation of RMR

•

Steady state should be achieved, which would be identified clinically by the
following criteria: 5 minute period when average minute VO2 and VCO2 changes
by less than 10%, average RQ changes by less than 5%

•

Stable interpretable measurements should be obtained in a 15 to 20 minute test.

•

Renal failure patients requiring hemodialysis should not be tested during dialysis
therapy.

Recommendations
Before starting an RMR test, it is necessary to select and calibrate the turbine used.
Read carefully the calibration procedure, in the Calibration chapter.

Resting metabolic rate test using the face mask
Use the following correction for the dead space (VD):
- 50 ml for the small mask
- 60 ml for the medium mask
- 70 ml for the large mask

Resting metabolic rate test using the canopy option
1.

2.

Verify (before and during the test) that the FeCO2 falls within the range 0.7%-1.3%
and adjust the flow rate of the pump as necessary. If the FeCO2 is too low you
should decrease the flow rate and if the FeCO2 is too high you should increase the
flow rate. A low FeCO2 may result in unreliable measurements, while a high FeCO2
could be dangerous for the patient.
Do not place Canopy hood over a patient’s head before the tube is properly
connected and a continuous flow is applied from Canopy Blower.
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Performing a test using the face mask
Calibrations
Before the test, it is necessary to perform an ergo calibration (see Calibration chapter)
and it is advisable to perform also a turbine calibration (see Recommendations in this
chapter).

How to prepare a patient
The patient interfaces with the equipment by means of a face mask, as depicted in the
following image. The mask has to be tight to the face, in order to avoid any air leakage.

C
A
B

RMR

Make sure that the subject health status is acceptable according to what stated in the
guidelines.
Make the subject sit or lay on a comfortable chair or bed.
Fix the mask to the subject, as illustrated in the above picture, pull the elastic strings
(Point A and B) accurately in order to eliminate possible leaks. The mask must be
perfectly sealed to the face of the subject, especially in correspondence with the nose
(point C).
The mask adapt differently according to the face shape of the subject. The perfect
position is therefore to be determined from subject to subject.

Start the test
1.
2.
3.
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Enter in the ergometry program
Select a patient or add a new one (File/Patients...)
Select Start test from Test menu

4.
5.

Enter the patient’s data and select the RMR mode (1st picture).
Press Other Data… and enter the dead space value (50ml Small mask, 60ml
Medium mask and 70ml Large mask). It is possible to enter the Ureic Nitrogen
value NU (2nd picture).
6. Confirm and start the test by pressing OK.
Selecting RMR the system set automatically the following options:
•

Data acquisition with a 30 seconds average

•

RMR protocol, which is:
- 5 minutes discarded;
- 10 minutes with data acquisition, of which the software will make an average at
the end of the test;
- automatic end of the test after the 16th minute.

• Selection of the RMR workspace (windows placement);
The test is fully automatic, the software will stop it and save the data at the end of the
16th minute.
The real time view is as shown in the following picture:

Chapter 8 - Resting Metabolic Rate Test - 105

Viewing the test
At the rend of the test, it will be opened automatically a window with the test results.

At the end of the test, or if it is selected View/RMR, the main results are shown:

Nota: The percentage of used
Proteins (PRO%) is calculated
assuming 12 grams of Ureic
Nitrogen in 24 hours. You can
modify this value selecting
View/Information… ->
Modify…

•

The average time interval (default: 10 minutes)

•

Average values of VO2, VCO2, R, RMR, RF, VE, HR, FAT% and CHO% and
predicted values if available.

•

Body Mass Index (BMI) and interpretation

•

Graph of the energetic expenditure for all the data acquisition interval, highlighting
the selected average interval.
In order to verify the goodness of the test, check that the ventilation and respiratory
frequency are similar to the predicted ones (12 breaths/min for the respiratory frequency
and 6 litres/min for the ventilation), and the heart rate is the rest heart rate of the patient.

How to modify the average interval
If the average interval (automatically identified by the software) is not satisfying, for
example because the patient was speaking in the first minutes, it is possible to modify
the interval of the average.
Right-click and select Edit RMR…. It is possible to move the start and the end lines.

To move the start line, left-click on the exact time in which you want to start the
calculations, for the end line, right-click.
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Print
The print of the current window generates a report similar to the one in the following
page.
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Performing a test using the canopy option
The principle of a ventilated bubblehood system is that a stream of air is forced to pass
across the face of a subject and mixes with the air which is collected by a transparent
hood, placed over the subject’s head. A measurement system, knowing the flow rate,
calulates the oxygen consumption and the CO2 production and, starting from these
values, the energy expenditure.

Calibrations
Before the test, it is necessary to perform an ergo calibration (see Calibration chapter)
and it is advisable to perform also a turbine calibration (see Recommendations in this
chapter).

How to prepare the canopy and the patient
Replacement of the power plug

If the power plug does not fit into the mains socket, replace it with the one in the
packaging.
In order to replace the plug:
1. Extract the plug from the battery charger
2. Insert the proper plug in the battery charger.

Connecting the Canopy

1.
2.
3.

4.
5.
6.
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Connect the Canopy unit to the mains by means of the medical grade AC/DC
adapter provided.
Fix the vail to the bubblehood through the velcro strips.
Insert the bubblehood adapter into the bubblehood from the outside and fix it
screwing the ring from the inside, being careful to insert it in the proper hole, as
shown in the following picture.

Connect the bubblehood to the wrinkled tube, interposing a bacterial filter.
Connect the wrinkled tube to the unit through the Flow in connector.
Connect the optoelectronic reader of the K4 b2 to the Flow out connector of the
Canopy unit.

How to prepare the patient

1.

2.

3.
4.

Switch on the Canopy unit. If there are no problems, the red led on the front panel
of the unit flashes for few seconds and the alarm beeps. If the led does not flash
and/or the alarm does not beep, the test cannot be performed, because the backup
battery is exhausted or there is no backup battery.
When the green led turns on, the test can start. If the green led does not turn on, the
red led flashes and the alarm beeps, the test cannot be performed because the pump
does not work or the mains does not power the system.
After these checks, put the patient in a supine position.
Place the bubblehood with the vail on the patient’s head. The tube has to be placed
near the patient’s mouth.

Warning! Do not place Canopy hood over a patient’s head before the tube is properly
connected and a continuous flow is applied from Canopy Blower.

Performing the test
1.
2.
3.

Enter in the ergometry program
Select a patient or add a new one (File/Patients...)
Select Start test from Test menu.

4.
5.
6.

Enter the patient’s data and select the Canopy mode.
Confirm and start the test by pressing OK.
In the first part of the test the flow rate of the pump has to be adjusted by means of
the Flow adjustment handle on the front panel of the Canopy unit, in order to
measure an FeCO2 between 0.7% and 1.3%. FeCO2 values can be read on the right
side of the PC monitor.
When the FeCO2 remains within the acceptability range, press F2 to start the data
acquisition. Verify, also during the test, that the measured FeCO2 is within the
0.7%-1.3% range. Otherwise, adjust it by means of the Flow adjustment handle.

7.
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Warning: If the green led turns off during the test, the red led flashes and the alarm
beeps, abort the test, because the pump does not work or the mains does not power the
system. In the last case, the pump works only because of the backup battery.
The test is fully automatic, the software will stop it and save the data at the end.

Viewing the test
At the rend of the test, it will be opened automatically a window with the test results.
At the end of the test, or if it is selected View/RMR, the main results are shown:

Note: The percentage of used
Proteins (PRO%) is calculated
assuming 12 grams of Ureic
Nitrogen in 24 hours. You can
modify this value selecting
View/Information… ->
Modify…

•

The average time interval (default: 10 minutes)

•

Average values of VO2, VCO2, R, RMR, VE, HR, FAT% and CHO% and predicted
values if available.

•

Body Mass Index (BMI) and interpretation

•

Graph of the energetic expenditure for all the data acquisition interval, highlighting
the selected average interval.
In order to verify the goodness of the test, check that the FeO2 and FeCO2 values are
within the acceptability ranges (20.2%-20.8% and 0.5%-0.8% respectively), and the
heart rate is the rest heart rate of the patient.

How to modify the average interval
If the average interval (automatically identified by the software) is not satisfying, for
example because the patient was speaking in the first minutes, it is possible to modify
the interval of the average.
Right-click and select Edit RMR…. It is possible to move the start and the end lines.
To move the start line, left-click on the exact time in which you want to start the
calculations, for the end line, right-click.

Print
The print of the current window generates a report similar to the one of the RMR test
using the face mask.

110 - K4 b2 User Manual

Sub-maximal
Exercise Testing

Introduction
Several physiological responses to exercise are used to evaluate cardiorespiratory
fitness, including oxygen consumption, heart rate, and blood pressure. Measuring these
variables during exercise, particularly maximum exercise, increase the chance of
detecting any coronary artery disease or pulmonary disease.
Unfortunately, maximum exercise tests are impractical because they are expensive,
require extensive clinical supervision, and subject individuals to levels of physical stress
that may be unnecessary depending on the objectives of the test. Consequently,
maximal testing is reserved for clinical assessments, athletic evaluation, and research.
A sub-maximal exercise test costs less and carries a lower risk for the individual.
Although less sensitive and specific for detecting disease or estimating maximal oxygen
consumption, correctly performed sub-maximal tests can provide a valid estimate of
cardiorespiratory fitness.

Pre-test screening
Pre-test health screening is essential for risk stratification and for determining the type
of test that should be performed and the need for an exercise test prior to exercise
training. A thorough pretest health screening includes the following:
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•

Complete medical history

•

Medical contraindications to exercise

•

Symptoms suggesting cardiac or pulmonary disease

•

Angina or other forms of discomfort at rest or during exercise

•

Unusual shortness of breath at rest or during exercise

•

Dizziness or light-headedness

•

Orthopaedic complications that may prevent adequate effort or compromise the
validity of test results

•

Other unusual signs or symptoms that may preclude testing

•

Risk factors for coronary heart disease

•

History of major cardiorespiratory events

•

Current medications

•

Activity patterns

•

Nutritional habits

•

Reading and signing an informed consent form

Sub-maximal exercise testing
Heart rate varies linearly with VO2 to the point of maximum exertion; thus, VO2max may
be estimated using the relation between heart rate and VO2 without subjecting the
individual to maximum levels of physical stress. During sub-maximal exercise testing,
predetermined workloads are used to elicit a steady state of exertion (plateau of heart
rate and VO2). The steady-state heart rate at each work level is displayed graphically
and extrapolated to the VO2 at the age-predicted maximal heart rate (HR = 220-age). A
variety of protocols for different exercise modalities (i.e., treadmill, stationary cycle,
and step increments) can be used as long as the VO2 requirements of each selected
workload can be estimated with accuracy.
The objectives of cardiorespiratory fitness assessments in the apparently healthy
population are as follows:
•

Determine the level of cardiorespiratory fitness and establish fitness program goals
and objectives.

•

Develop a safe, effective exercise prescription for the improvement of
cardiorespiratory fitness.

•

Document improvements in cardiorespiratory fitness as a result of exercise training
or other interventions.

•

Motivate individuals to initiate an exercise program or comply with an established
program.

• Provide information concerning health status.
A few assumptions regarding testing are necessary to ensure the highest degree of
accuracy when using sub-maximal exercise testing to estimate VO2max:
•

Selected workloads are reproducible. A steady-state heart rate is obtained during
each stage of the test. Usually, workload durations of 3 minutes or more are used to
ensure steady state.

•

The maximal heart rate for a given age is uniform (HR = 220-age).

•

Heart rate and VO2 have a linear relation over a wide range of values; thus, the
slope of HR/VO2 regression can be extrapolated to an assumed maximum heart
rate.

• Mechanical efficiency (i.e., VO2 at a given work rate) is consistent.
Although if done correctly, sub-maximal exercise tests provide valuable information
concerning cardiorespiratory fitness, they have extremely limited diagnostic capabilities
and should not be used as a replacement for clinical exercise tests or other clinical
treatment or management modalities. Health care professionals should avoid detailed
interpretation beyond the scope of the information obtained.

Considerations with sub-maximal exercise testing
Considerations for selection of protocol and equipment include any physical or clinical
limitations that may preclude certain types of exercise (i.e., age, weight, arthritis,
orthopaedic complications, individual comfort, level of fitness, type of exercise training
that will be performed, and individual preference).
For example, some individuals may perform better on a non-weight-bearing modality
(cycle versus treadmill), while others may not have the required range of motion in the
hip or knee to pedal and may perform better walking. Deconditioned, weak, or elderly
persons may have to start the test at a low work level and increase the workload in small
increments. Also, field tests may not be appropriate for those who require strict
supervision during testing, who do not understand the concept of pacing, or who cannot
be expected to put forth a good effort. More consistent results may be obtained by
testing in a controlled environment such as a laboratory setting. Creativity when
selecting protocols may allow adaptations of commonly used protocols to accommodate
athletes competing in specific sports. Regardless of the type of exercise and protocol
selected, the same type of exercise and protocol should be used for repeat testing if
between-test comparisons are important.
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Staffing
Staff members should be able to do the following:
1. Establish rapport with the subject and make him or her feel comfortable.
2. Recognize normal acute and chronic responses to exercise.
3. Recognize abnormal signs and symptoms during exercise.
4. Provide basic life support measures competently.
5. Adhere to established procedures and protocols.
6. Clearly explain test results to the individual.

Test termination
Sub-maximal tests should be terminated according to ACSM or other accepted
guidelines (see table in the following). In the event of an abnormal response, the test
should be terminated, the medical director of the facility and the individual’s primary
care physician notified, and all specified follow-up procedures performed. In the event
of mechanical or electrical failure that may compromise the accuracy of the test results
or monitoring capabilities, the test should be terminated until the problem is corrected.
General Indications for Stopping an Exercise Test in Apparently Healthy Adults

Onset of angina or angina-like symptoms
Significant drop (20 mmHg) in systolic blood pressure or a failure of the systolic blood
pressure to rise with an increase in exercise intensity
Excessive rise in blood pressure: systolic pressure >260 mmHg or diastolic pressure
>115 mmHg
Signs of poor perfusion: tight-headedness, confusion, ataxia, pallor, cyanosis, nausea, or
cold and clammy skin
Failure of heart rate to increase with increased exercise intensity
Noticeable change in heart rhythm
Subject requests to stop
Physical or verbal manifestations of severe fatigue
Failure of the testing equipment
Assuming that testing is non-diagnostic and is being performed without direct physician
involvement or electrocardiographic monitoring.
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Considerations for accuracy
The ability to obtain valid and reproducible results is essential to ensure that any
differences between pre-treatment and post-treatment test results are due to exercise
training rather than variations in testing procedures. Some inconsistencies that are
inherent may increase variability:
•

Sub-maximal heart rate is influenced by time of day, eating, smoking, and
familiarization with test procedures.

•

Prediction equations for estimating VO2max may overestimate trained individuals
and underestimate untrained individuals.

•

The efficiency of motion during walking, running, and cycling varies.

• Cardiac output and VO2 have a test-retest variability of 3-4%.
Psychological factors, such as pre-test anxiety, may influence the heart rate, especially
at rates below 120 beats per minute and at low workloads. It is not unusual for the heart
rate and/or blood pressure to be higher at rest than during the initial stages of exercise in
these cases. Having the subject repeat the first test may improve reliability, particularly
if the subject has never previously performed such a test.
Factors that can cause variation in the heart rate response to testing:
•

Dehydration

•

Prolonged heavy exercise prior to testing

•

Environmental conditions (e.g., heat, humidity, ventilation)

•

Fever

• Use of alcohol, tobacco, or caffeine 2 to 3 hours prior to testing
Because of these inherent inconsistencies, standard procedures for each test must be
strictly followed to ensure the greatest accuracy and reproducibility possible:
•

Standard testing protocol

•

The same testing modality and protocol for repeat testing

•

A constant pedal speed throughout cycle ergometry testing

•

Cycle seat height properly adjusted, recorded, and standard for each test

•

The time of day for repeat testing consistent

•

All data collection procedures standardized and consistent

•

Test conditions standard

•

Subjects free of infection and in normal sinus rhythm

•

Prior to the test, no intense or prolonged exercise for 24 hours, smoking for 2-3
hours, caffeine for 3 hours, or heavy meal for 3 hours

•

Room temperature 18-20°C (64-68°F) with air movement provided
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Performing the test
In this chapter it is supposed that the user is able to:
•

perform an exercise test

•

create exercise protocols

• view, edit and print tests
If this is not the case, please read the Exercise testing chapter.
To perform a sub-maximal test, follow these instructions:
1. Create a proper protocol (procedural guidelines for several sub-maximal testing
protocols are provided in [ACSM’s Guidelines for Exercise Testing and
Prescription, 6th Edition Philadelphia: Williams&Wilkins, 2000:22-29]).
2. Start an exercise test.
3. Perform the test as it were a maximal exercise test, ending it when the heart rate
reaches the 85% of the Hrmax, or it happens an event listed in the section Test
termination.
4. Display a VO2/Kg vs. HR plot
5. Right-click on the graph and select VO2 submax from the pop-up menu.

If the predicted HR max (calculated as 220-age) is not suitable for the patient tested, it
is possible to edit the HR max value from the View/Information… page.

An example of testing protocol
An example of protocol is reported here. The
defined as follows.
1st step: workload 150 kgm/min
2nd step: if the HR at the end of the 1st step is:
set the workload at (kgm/min)
rd
3 step: if the HR at the end of the 2nd step is:
set the workload at (kgm/min)
th
4 step: if the HR at the end of the 3rd step is:
set the workload at (kgm/min)
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YMCA cycle ergometry protocol is

<80
750
<80
900
<80
1050

80-89
600
80-89
750
80-89
900

90-100
450
90-100
600
90-100
750

>100
300
>100
450
>100
600

The mixing chamber

The mixing chamber
Overview
The mixing chamber is a 7-litres plexiglas box, for exercise or resting (VE<40 l/min)
tests. For resting tests only a part (about 2.3 litres) of the mixing chamber is used.
The mixing chamber is shown in the following picture:

6

3

1
4

7
5
2

7
1.
2.
3.
4.
5.
6.
7.

Connector for the sampling line, for resting tests or tests with VE<40 l/min.
Connector for the sampling line, for exercise tests or tests with VE>40 l/min.
Inlet for patient’s exhaled air.
Connector to be closed with the proper plug supplied with the equipment.
Outlet for patient’s exhaled air.
Little plug for closing the connectors #1 or #2.
Fixing holes.

Preparing the mixing chamber for a test
1.
2.
3.
4.
5.

Connect the wrinkled tube to the inlet #3 of the mixing chamber.
Connect the turbine to the outlet #5 of the mixing chamber.
Disconnect the sampling line from the turbine and connect it to the connector #1
(for resting tests) or #2 (for exercise tests) of the mixing chamber.
Close the connector #2 (for resting tests) or #1 (for exercise tests) of the mixing
chamber with the little plug #6.
Close the connector #4 with the proper plug supplied with the equipment.

Two-way non rebreathing valve description
The two-way non rebreathing valve is very important in order to perform the test
properly. It is shown in the following picture:
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1

3
2

1.
2.
3.

Valve inlet
Connector for the mask
Valve outlet

Note: be very careful in order to differentiate inlet from outlet. These two are not
interchangeable, to guarantee proper functionality.

Patient’s preparation
1.
2.
3.

Screw the mask to the connector #2 of the valve.
Connect the wrinkled tube to the outlet #3 of the valve.
Fix the mask as illustrated in the picture below. Adjust the elastic bands on the head
cap as necessary to eliminate possible leaks and create a tight seal around the
subject’s face.

4.

Complete the patient preparation as indicated in the chapter Exercise testing.

1.

Calibrate the analyzers as described in the Calibration chapter

2.
3.

or press F2.
Select Test/Execute Test or press the icon
Select Mixing chamber in the Execute test window and perform the
exercise/resting test as illustrated in the chapter Exercise testing.

Performing the test

The mixing chamber - 119
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Spirometry

Setting spirometry options
The software allows to configure some options selecting Configure from the Option
menu.

Spirometry

Automatic Interpretation

K4 b2 has the function of interpreting each test performed by a patient visualising an
automatic diagnosis. The algorithm has been calculated basing on “Lung Function
Testing: selection of reference values and interpretative strategies, A.R.R.D. 144/
1991:1202-1218”.
The automatic diagnosis is calculated at the end of the FVC Test if:
•

the automatic diagnosis option is enabled.

•

the patient’s anthropometric data allow the calculation of the LLN (Lower Limit of
Normal range).

• at least one FVC test has been performed.
To enable/disable the automatic diagnosis:
1. Click on Enable Automatic Interpretation checkbox to enable or disable the
calculation and the visualisation of the automatic interpretation.
2. Select the LLN (Lower Limit of Normal Range) criteria among the ATS
(LLN=Pred-0.674*SD), ERS (LLN=Pred-1.647*SD) or 80%Pred (LLN=Pred*0.8)
specifications.
Quality control

K4 b2 allows a quality test control. The calculation has been carried out referring to
“Spirometry in the Lung Health Study: Methods and Quality Control, A.R.R.D. 1991;
143:1215-1223”. The messages concerning the quality control are shown at the end of
the test.
To enable/disable the quality control, click on Enable Quality Control checkbox.
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Parameters manager

The program allows to calculate a huge number of parameters; it is advisable, in order
to simplify the analysis of the results, to view, to print and to sort the desired parameters
only. Select the menu item Options/Parameters...
View
Move the parameters to view into the Selected parameters list.
Print
Move the parameters to print into the Selected parameters list.
Sort
Drag the parameter up or down with the mouse.
Customise
Add, modify and delete custom parameters.
If it is necessary to restore the default parameters press the button in the left corner of
the window to initialise the parameters database.

Predicted values manager

The program contains a preset of predicted equations, but the user is allowed to
customise its own predicted sets. Select Predicteds... from Options menu.
The window is divided into two forms: Predicteds set and Formula definition.
Predicteds set

This form allows the user to manage the set of predicteds. The following information
define a set:
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Name:
identifies the set and cannot be duplicated;
Description: free field;
Age:
the adult predicteds start since this age.
To enter a new set of predicteds click on the New button. The field Name must be filled
and must be unique. To stop without saving click on the Cancel button. To save the set,
click on the Save button.
To delete a set of predicteds click on the Delete button. If a set is deleted, also the
associated formulae are deleted.
It is possible to generate a new set of predicteds with the same attributes and the same
formulae of the selected one. To do this click on the Copy... button and specify a new
Name.
To import a set of predicteds click on the Import... button and select a file of Predicteds
files type.
To export a set of predicteds click on the Export... button.
In the list Set current predicteds choose the current predicteds for printing and
viewing.
Set the current predicted

K4 b2 allows to calculate the predicted values according to the following configurable
sets:
Adult

Paediatric

ERS 93
Zapletal
Knudson83
Knudson83
ITS white
ITS white
ITS black
ITS black
LAM
LAM
MC Barcellona
MC Barcellona
Nhanes III
Nhanes III
Select the desired choice in the group Predicted.
Formula definition

This form allows the user to manage the formulae associated to a set of predicteds.
Select the set of predicteds from the list Predicteds set.
To insert a new parameter click on the New... button.
The parameter formulae can be:
124 - K4 b2 User Manual

•

calculated according to the predicteds in the list Use the predicteds formulae;

• customised by the user with the option ...or the customised formulae.
The Delete button deletes the selected parameter.
The Copy button stores the selected parameter in memory.
The Paste button inserts a new parameter from the one copied. If the name is not
unique, the user is asked whether to specify a new name or to replace the existing
parameter.

Page set-up

Select Page Setup... from the File menu.
Header
All the printouts carried out by the program are preceded by 3
rows of customisable header (usually they contain the name
and the address of the Hospital using the spirometer).
Data
Patient and visit information are printed below the header.
These data are reported on 3 columns and 5 rows. the user may
configure the disposition, change and eventually cancel the
fields, as he prefers.
Margins
Configures the print margins from the borders of the paper.
The unit of measure is decided in Units of measurements.
Footer
Configures information at the bottom of the page.
Printed file name
Defines the automatic name to be asssigned to the pdf file, if
the report will be printed in this format.

In the example it has been set to create a filename composed by
<date of the test> followed by <last name> and <first name>.
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Spirometry tests
Once completed the phases of the introduction of the patient’s data and the visit data, it
is possible to carry out the spirometric tests.
K4 b2 allows to perform the following tests:
Note: Read carefully the
contraindications in Chapter 1.

Key

Test

FVC pre
Forced Vital Capacity
FVC post
Forced Vital Capacity after bronchial stimulation
SVC
Slow Vital Capacity
MVV
Maximum Voluntary Ventilation
Before performing any test make sure that:
1. K4 b2 is properly connected to your PC and the selected serial port (COM1, COM2)
corresponds to the one effectively use.
2. The name shown on the status bar corresponds to the patient who is to carrying out
the tests.
3. The today’s visit card exists.
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Forced Vital Capacity (pre)
FVC is a reference test to verify obstructive (airflow limitations) and restrictive
disorders (lung volume limitations). To achieve good test results it is fundamental a
good manoeuvre (quality control messages, real time plots …)
The main parameters measured during FVC tests are:
FVC
Forced Vital Capacity
FEV1
Forced Expiratory Volume in 1 second
FEV1/FVC%
FEV1 as a percentage of FVC
PEF
Peak Expiratory Flow
FEF25-75%
Forced mid-Expiratory Flow
The two representative plots are the Flow/Volume and Volume/Time loops.
By comparing FVC, FEV1 and FEV1/FVC% values the software allows an automatic
interpretation concerning the levels of obstructive and/or restrictive disorders.

Recommendations
•

The flowmeter has to be disconnected from the breathing valve

•

The patient should wear the nose clips

•

The turbine has been recently calibrated (ATS recommends a daily calibration)

•

The paper mouthpiece or the antibacterial filter is properly connected to the
flowmeter through the corresponding adapter
For hygienic reasons, we strongly recommend the use of a bacterial filter.
If a kid must perform the test it is recommended to enable the encouragement function
which shows exactly the manoeuvre of the FVC test.

Perform a FVC (pre) test
1.
2.
3.
4.

5.

Select Forced Vital Capacity pre from the Test menu and wait for the green led is
prompted on the right side of the screen.
Explain the manoeuvre to the patient and press the F2 key.
Wait some seconds and perform the test.
After having performed the test, press F3 or wait for the automatic end (5 seconds
without flow), so that the software displays the F/V and V/t graphs, the main
parameters, and the predicteds values.
In order to visualise the F/V and V/t graph and the main parameters press the
following buttons:
view Flow Volume graph
view Volume Time graph

6.
7.
8.
9.

view data of the test
Press Alt+F3 to stop the acquisition discarding the results.
Repeat the test until it is correctly performed (ATS recommends 3 times).
Press Exit to visualise the test list carried out during current session together with
the results of the main parameters.
Select the test that you want to save (the Best Test according to the ATS criteria is
highlighted as default) and press OK.

Test encouragement
During FVC manoeuvre you might experience some lack of collaboration with kids or
with other patients. In this case you may find a good help in using the encouragement
software tool.
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Perform the FVC test with the encouragement

1.
2.
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Select Encouragement from View menu.
Perform the test as explained in the previous paragraph.

Slow Vital Capacity
Important test for assessing COPD (chronic obstructive pulmonary disease) patients
affected by this disease might present a the Slow Vital Capacity could be higher than
the Forced one (FVC).
The main parameters measured during SVC tests are:
EVC
Expiratory Slow Vital Capacity
IVC
Inspiratory Slow Vital Capacity
ERV
Expiratory Reserve Volume
IRV
Inspiratory Reserve Volume
If the inspiratory/expiratory maximal manoeuvre is preceded by a some breaths at tidal
volume the software allows to measure the Respiratory Pattern, represented by the
following parameters:
VE
Ventilation per minute
Vt
Tidal volume
Rf
Respiratory frequency
Ttot
Breath time
Ti/Ttot
Inspiratory time/Ttot
Vt/Ti
Vt/Ti

Perform a SVC test
1.
2.

3.

4.

Select Slow Vital Capacity from the Test menu and wait for the green led is
prompted on the right side of the screen.
Press F2 and instruct the Patient to breath normally until the message “carry out…”
is prompted; then ask to perform a Slow Vital Capacity (deep inhalation, maximal
slow expiration and deep inhalation again).
Press F3 or wait for automatic interruption (5 seconds without flow) in order to
visualise the V/t graph together with the main parameters compared to the predicted
values
To visualise the V/t graph and the main parameters press the follow buttons:
view Volume Time graph

view data of the test
Press Alt+F3 to stop the acquisition discarding the results.
Repeat the test until it is correctly performed (ATS recommends 3 times).
Press Exit to visualise the test list carried out during current session together with
the results of the main parameters.
8. Select the test that you want to save (the Best Test according to the ATS criteria is
highlighted by default) and press OK.
The reference for the ERV calculation is displayed on the V/T graph.

5.
6.
7.
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Maximum Voluntary Ventilation
Test for assessing the maximum ventilatory capacity. In the past, it was commonly
performed during routine PF tests, however its clinical use declined over the years.
Today MVV test is most commonly performed as part of the exercise tolerance tests,
where it is used as an index of maximum ventilatory capacity. Test consists in breathing
in and out deeply and rapidly for 12, 15 seconds. The expired volume during this short
period is then extrapolated
The most important measured parameter is the following:
MVV
Maximum Voluntary Ventilation

Perform a MVV test
1.
2.
3.

4.

Select Maximum Voluntary Ventilation from the test menu and wait for the
green led is prompted on the right side of the screen.
Press F2 and make the Patient breath as much deeply and rapidly as possible for at
least 12 seconds.
Press F3 or wait for automatic interruption (5 seconds without flow) in order to
visualise the V/t graph together with the main parameters compared to the predicted
values
To visualise the V/t graph and the main parameters press the follow buttons:
view Volume Time graph

5.
6.
7.
8.
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view data of the test
Press Alt+F3 to stop the acquisition discarding the results.
Repeat the test until it is correctly performed (ATS recommends 3 times).
Press Exit to visualise the test list carried out during current session together with
the results of the main parameters.
Select the test that you want to save (the Best Test according to the ATS criteria is
highlighted as default) and press OK.

Bronchial Provocation Test
Bronchodilator test
Note: Read carefully the
contraindications in Chapter 1.

Bronchodilators are administered routinely in the b2 laboratory to determine whether
airflow obstruction is reversible. Bronchodilators increase airway calibre by relaxing
airway smooth muscle.
The test consists of comparing results between the reference FVC (FVC PRE) and the
FVC POST performed after the administration of the drug. Increasing value of 13-15%
of FEV1, respect to the basal value (FVC Pre) is considered as a reversible condition.
Main parameters are the following:
DFEV1%pre
Change of FEV1 as a percentage of test PRE
DFVC%pre
Change of FVC as a percentage of test PRE
DPEF%pre
Change of PEF as a percentage of test PRE
Some authors states that the above mentioned parameters are too dependent from the
FVC Pre, hence latest reference (ERS93, [A comparison of six different ways of
expressing the bronchodilating response in asthma and COPD; reproducibility and
dependence of pre bronchodilator FEV1: E. Dompeling, C.P. van Schayck et Al; ERJ
1992, 5, 975-981]) recommend the following parameters:
DFEV1%pred Change of FVC as a percentage of predicted value
DFEV1%poss Change of FEV1 as a percentage of “possible value”

Methacholine and Histamine Bronchial provocation Tests
The most common indication for performing methacholine and histamine bronchial
challenges is to diagnose hyperresponsive airways. Some patients demonstrate normal
baseline pulmonary function despite complaints of “tightness” wheezing, cough, and a
little or not response to bronchoconstrictor. Other patients demonstrate spirometric
improvement after use of bronchoconstrictor have diurnal variation in peak flows. In
this groups aerosolised bronchial challenges are used to confirm a diagnosis of Asthma.
We can summarise the use of the test as follows:
1. Diagnose asthma
2. Confirm a diagnosis of asthma
3. Document the severity of hyperresponsivness
4. Follow changes in hyperresponsivness
When patients with hyperresponsive airways inhale certain pharmacologic agents (i.e.
Methacholine or histamine) the airways respond by constricting.
Test consists of executing repeated FVC following the pharmacologic agents inhalation
according to an established protocol. The fall of the FEV1 parameter is used to calculate
the bronchial hyperresponsivness. The most important parameter is the PD20 that is
amount of drug (mg/ml) that causes a reduction of 20% of the FEV1 respect the basal
value (without drug).
Main parameters are:
P10 Dose that causes a 10% fall of FEV1.
P15 Dose that causes a 15% fall of FEV1.
P20 Dose that causes a 20% fall of FEV1.
The representative plot is the Dose/response curve, showing the percentage variation of
FEV1 versus the Drug dose in logarithmic scale.
The program assumes as the baseline test the best FVC pre carried out during the
today’s visit. You can change the reference pre test editing the Post test.
The name of the drug, its quantity and its unit of measurement, can be typed
immediately before any FVC post manoeuvre (manual protocol) or can be stored in a
database of bronchoprovocation (File/Bronchial Provocation protocols Database…).
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Perform the test
(During 1st step only) select Protocol... from the Test menu and choose the name of the
bronchoprovocation protocol that you are going to use (manual protocol if you want to
type the information about the agent before any manoeuvre)
1. Select FVC post from the Test menu.
2. Select an existing protocol or click on “manual protocol”, and wait the green leds
turned on.
3. Press F2, or the button by side, to start the test.
4. Press F3, or the button by side, to achieve the test.
5. In order to visualise the V/t graph and the main parameters press the follow
buttons:
view Flow Volume graph
view data of the test

6.
7.
8.
9.

view bronchial provocation response
Press Alt+F3 to stop the acquisition discarding the results.
Repeat the test until it is correctly performed (ATS recommends 3 times).
Press Exit to visualise the test list carried out during current session together with
the results of the main parameters.
Select the test that you want to save (the Best Test according to the ATS criteria is
highlighted as default) and press OK.

Bronchial Provocation protocols Database
The response to a bronchoprovocator is usually assessed in terms of change in the
FEV1, vital capacity or airways resistance on the basis of serial measurements (FVC
manoeuvres) in which the results of the initial test constitute the reference values. The
international literature proposes several standardised protocols in order to address the
methodological issues of the various available techniques.
The possibility to store a bronchoprovocation protocol in a database is useful to simplify
and automate the sequence of operations that the Physician need to execute during the
bronchoprovocation tests.
The typical sequence of activities to carry out a bronchoprovocation test are:
1. Typing and storing a bronchoprovocation protocol in the database (usually only
once).
2. Selection of protocol among the list of the ones already present in the database
before carrying out the FVC post tests (the selection of “manual protocol” allows to
execute the test fully manually).
3. Performing the Post tests.
Enter a new Bronchial provocation protocol in the archive

1.
2.
3.
4.
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Select Bronchoprov. protocols database from the File menu.
Type the Protocol name, the Bronchoprovocator name and the unit of measurement
in the proper input fields.
If the bronchoprovocator has a cumulative effect select the cumulative check
button.
Enter the quantities for each step and press the button

.

Viewing results
All the visualisation functions refer to the test carried out by the Current Patient, whose
name is indicated on the left-side of the status bar.
To view tests results:
1. Select the Patients from the File menu
2. Select the patient corresponding to the test you want to view.
3. Select in the list box of the tests up to 5 tests of the kind (FVC, VC/IVC, or MVV)
and press OK.
To switch between graph and or data use the following buttons on the toolbar:

view Flow Volume graph (F5)

view Volume Time graph (F6)

view data of the test (F7)

view bronchial provocation response.
If you need more than one visualisation meantime use the New Window function from
the Window menu.
If you need to display a list of visits:
•

Select Visits list... from the File menu.

•

Type the name of the Company and/or the time interval desired or simply confirm
for the complete list.

Tests of the current patient

If a current patient has been selected you can quickly view his tests selecting Test
current patient... from the View menu.
Delete a test

1.
2.

Select Patients from the File menu or press the button by side.
Select the test that you want to eliminate from the list of the tests referred to the
Current Patient and press Delete.
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Printing results
You can print out in three different ways:
•

printing the Report

•

printing the Active Window

•

printing a series of reports

Printing Reports
To print a report of the current visit, select Print report… from File menu. The
software will choose automatically the best performed test.
The standard Report is composed by 1, 2 or 3 pages depending if you wish to printout
the FVC data and the graphs together on the first page or if you wish to printout the
bronchoprovocation response.
•

Selecting the option One page (no ATS) the report will contain, on one page, the
F/V and V/t graphs of the best test, overlapped on the FVC Post, the patient data,
the notes, the diagnosis and the test results.

•

Otherwise the report will contain two pages, the first with the patient data, the
graphs and the diagnosis, and the second one with the measured parameters,
according to the ATS recommendations.

• The 3rd page will contain the bronchoprovocation response.
Select the desired options:
FVC graph
Prints the F/V and V/t curves for the best FVC test.
One page (no ATS)
Prints data and graphs on the first page.
Response
Prints the bronchoprovocator response.
Preview
Views a report preview on the screen.

Printing the active window
This printout function is only enabled when the active window (title bar highlighted) is
one of the following objects:
•

Any kind of Graph.

•

Numeric data

•

List of visit

To print the active window

1.
2.

Ensure that the active window is one of the preceding objects.
Select Print Active window from File menu.

Printing a series of reports
Sometimes it is useful to printout automatically a series of reports (all tests carried out
with the employees, all tests carried out in the today's session).
To print out proceed as follows:
1. Select Visit List from the File menu
2. Set the criteria of the visits to be added in the list (from, to,...)
3. Select Print Report from the File menu.

Electronic reports (*.pdf)
If an Adobe PDF writer “Printer Driver” is installed and set as the default printer, it is
possible to store the printout report automatically in any location of the HD or
eventually LAN paths according to a customizable filename format.
It is possible to define the created filename format selecting File/Page Set up... (see
Page set-up).
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Export data
With this function you can export the test data in 4 different formats:
•

*.txt (ASCII)

•

*.xls (Microsoft Excel)

•

*.wk1 (Lotus 123)

•

*.xpo (Cosmed)

Export a test

1.
2.
3.

4.

Select Export tests from the File menu.
Select the test to export from the list box and press OK.
Type the name and the format of the file in the dialog Save as. If the ASCII format
is selected, the Text button in the dialog box Save as allows you to configure the
separators for character based files.
With the *.xpo Cosmed file format it is possible to import data from another K4 b2
archive. Press OK to confirm.
Select the folder for the export and type the file name. Press OK to confirm. A
status bar will show the file creation.
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External devices

GPS
GPS initialisation
The GPS operates on information gathered from satellites.To gather this information,
take your GPS on outside and find large, open area that has a clear view of the sky (a
nearby park would work fine). The GPS needs to receive at least three strong satellite
signals to find your location.
At the first power on the GPS needs to be initialized; the initialisation is a fundamental
procedure for obtaining accurate and reliable data and should be performed on a large
area where the sky is fully "visible".
After the initial self test is complete, the GPS will begin the process of satellite
acquisition and tracking. The acquisition process is fully automatic and, under normal
circumstances, will take approximately 45 seconds to achieve a position fix (15 seconds
if ephemeris data is known).
Like all GPS receivers, COSMED GPS utilizes initial data such as last stored position,
date and time as well as satellite orbital data to achieve maximum acquisition
performance. If significant inaccuracy exists in the initial data, or if the orbital data is
obsolete, it may take 5.0 minutes to achieve a navigation solution. The GPS
Autolocate™ feature is capable of automatically determining a navigation solution
without intervention from the user. This procedure may be required if one of the
following situations occurs:
1) Transportation over distances further than 1500 kilometers.
2) Failure of the internal memory battery without system standby power.
3) Stored date/time off by more than 30 minutes.
The GPS will automatically update satellite orbital data as it operates. The intelligence
of the GPS combined with its hardware capability allows these data to be collected and
stored without intervention from the host system.
Initialize the GPS

1) If the receiver is not operated for a period of six (6) months or more, the unit will
“search the sky” in order to collect satellite orbital information. This process is
fully automatic and, under normal circumstances, will take 3-4 minutes to achieve a
navigation solution.
2) If the memory backup battery of the GPS fails, the receiver will search the sky as
described above. Should the memory battery discharge, the unit needs to be
powered on for several hours to insure a sufficient recharge to maintain several
months of clock operation and memory storage.
3) If the initial data is significantly inaccurate, the receiver perform an operation
known as AutoLocate™ . This procedure is fully automatic and, under normal
circumstances, will require 1.5 minutes to calculate a navigation solution.
During the acquisition process a message "acquiring satellites...." is prompted on the
display of the Portable unit.
The AutoLocate™ function can be manually forced selecting GPS AutoLocate from
the Calibration menu, in order to obtain the best accuracy.

Fixing the antenna to the subject
The GPS Receiver has to be positioned onto the harness of the K4b2 according the
following pictures, paying attention to keep the receiver in a position so that the sky will
be always "visible" during the test.
Some applications such as cycle racing and rowing may require different positioning of
the antenna.
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Operating sequence
Test with GPS module can be carried out with K4 b2 system in Holter Data Record or
Telemetry Data Transmission mode only. In addition to the Operating sequence of this
mode you must carry out the following operation.
Run a test with GPS

1.

Connect the receiver antenna to the Portable Unit plugging phone jack into the
RS232 port at the bottom of the PU.

2.
3.

Select Settings then External device and press Enter.
Enable the GPS option by moving the “*” sign on GPS and press Enter to confirm
settings.
Check the GPS module functionality choosing Calibration then GPS Control and
press Enter. Display will show latitude and longitude.

4.

5.

With the use of Up and Down key verify that the displayed altitude value (Alt) is
different from zero. In case displayed altitude value is fixed on zero, please be sure
that the antenna receiver is well plugged in, the “sky” is visible and wait until the
Altitude value is shown.
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Monitoring GPS parameters in real time

To monitor in real time GPS parameters during Telemetry Mode Transmission or as
soon as test has been stored or downloaded, go to the PC software and select
Parameters to view/Test execution… (real time) or Parameters to view/Test
visualization… (after download) from the Options menu.
Select the following parameters:
Velocity
GPS Vel (m/sec)
Distance
GPS Dist (meters, incremented during exercise phases only)
Latitude
Lat (DD°MM.MMM’ N/S)
Longitude
Long (DD° MM.MMM’ E/W)
Altitude
Alt (meters)
Only when test has been stored or downloaded you can verify the Graphical path
(automatically drawn on a scaled X/Y plane oriented to North ) selecting on the PC
software Visualization and GPS track.
Note: Distance is automatically calculated only during the "exercise" phases.
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Pulse Oximeter (option)
The oximeter option is useful to monitor SpO2 value during the test. Test with this
option can be carried out with K4b2 system in Holter Data Record or Telemetry Data
Transmission mode only.
In addition to the Operating sequence of this mode you must carry out the following
operation:

Operating Sequence
1.

Connect the Oximeter module to the Portable Unit plugging phone jack into the
RS232 port at the bottom of the PU
2. Go to the K4b2 control panel and select Oximeter like External device connected by
choosing Settings than External device and press Enter
3. Enable the Oximeter option by moving the “*” sign on Oximeter and press Enter
to confirm settings.
4. Positioning Finger or Ear Clip on the patient and fix well the cable with Velcro
stripes on the harness to minimize motion artifact
To monitoring in real time SpO2 value during Telemetry Mode Transmission or as soon
as test has been stored or downloaded, go to the PC software, select Parameters to
view/Test execution… (real time) or Parameters to view/Test visualization… (after
download) from the Options menu and select SpO2 parameter.
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System
maintenance

System maintenance
All service operations which are not specified in this user manual should be performed
by qualified personnel in accordance with the service handbook (to be required to the
manufacturer).
Rubber mouthpieces, face masks, breathing valve and the other parts are not shipped
sterile. They should be disinfected before using according to the following instructions.
All materials used in the construction of the K4 b2 are non toxic and pose no safety risk
to the patient or operator.
Prior to the device cleaning, disinfection and inspection it is necessary to switch off the
device and to disconnect adapters from the supply mains.
In order to guarantee the highest accuracy of measurements we recommend you to
disinfect the turbine periodically.
Use disposable anti-bacterial filters or disinfect each part in contact with the patient
before each test.

Cleaning and disinfection
Cleaning and disinfecting instructions are of fundamental importance to control
infections and assure patient safety. In fact aspiration of residue, particles and
contaminated agents are life – threatening.
In this handbook we strongly recommend you to follow the rules worked out by ATS
and ERS (see: ”Lung Volume Equipment and Infection Control” – ERS/ATS
WORKSHOP REPORT SERIES, European Respiratory Journal 1997; 10: 1928 –
1932), which are summarised as follows:
•

Accessible internal as well as external surfaces of equipment exposed to expired
gas should be washed and disinfected prior to testing of subsequent patients.

•

Liquid disinfection can be used if the equipment is well cleaned first (no droplets of
saliva/sputum remain).

•

Disposable gloves should be worn when handling mouthpieces, when cleaning
equipment exposed to saliva or sputum and especially when drawing blood.

•

Laboratory staff should wash hands prior to testing of each patient.

•

Adopt particular precautions when testing patients with recognised high – risk
communicable diseases (e.g. tuberculosis, multidrug – resistant staphylococcus). In
these cases, the clinical need for such testing should justify the risks.
During the disinfection:
•

do not use alcohol or other liquids containing gluteraldehyde on the exterior
surfaces of the equipment. Actually they can damage polycarbonates plastics and
may produce unhealthy substances.

•

do not use abrasive powders or glass cleaners containing alcohol or ammonia on the
plexiglas components of the equipment

•

do not steam autoclave any parts of the equipment unless it is clearly specified.

•

do not immerse the optoelectronic reader.

Preparing the disinfecting solution

The following recommendations are retrieved from:
APIC (Association for Professionals in Infection Control and Epidemiology, Inc.):
APIC Guidelines for Selection and Use of Disinfectants; William A. Rutala, PhD, MPH,
CIC. American Journal of Infection Control, vol.24, N.4, pp. 313-342, August 1996 http://www.apic.org/pdf/gddisinf.pdf
As disinfecting solution it is suggested:
•

Sodium hypochlorite 0.5% (5000 ppm) prepared fresh for use within 24 hours.

• Sodium hypochlorite 1% (10000 ppm) prepared fresh for use within 30 days.
The first solution can be easily prepared by adding 1 part household bleach (sodium
hypochlorite 5.25%) to 9 parts water, the second one by adding 1 part household bleach
to 4 parts water.
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Cleaning the turbine flowmeter
Warning: Do not use
alcoholic solutions for the
turbine, otherwise there can
be damages to the plastic
material.

It is necessary to disinfect periodically the turbine for sanitary measures or/and for the
correct device function.
The disinfecting procedure is easy and may be effected every time the user needs,
keeping attention to some precautions:

1.
2.
3.
4.
5.
6.

Take out the turbine.
Dip it in a disinfectant solution (non alcoholic based) for about 20 minutes.
Rinse the turbine in a vessel, filled of clean water, shaking gently to remove the
disinfectant (do not clean the turbine by putting it under running water!).
Let it dry to air.
After cleaning the turbine, check if the turbine propeller rotates freely even with a
low speed air flow.
Connect the turbine to the reader.

Precautions during the cleaning of the turbine

1.
2.
3.

Do not expose the turbine to high heat and do not put it under running water.
Do not ever dip the optoelectronic reader in any kind of solution, the liquid
infiltration would damage the internal circuit.
Do not use alcoholic solutions to clean the turbine.

Masks cleaning and disinfection
The face masks should be cleaned and sterilised after each test.
Disassembling the different parts of the mask

1.
2.

Remove the valves from their place.
Remove the adapter for the optoelectronic reader.

Cleaning the mask

1.
2.

Clean the mask with hot water and a soap solution to remove the impurities.
Rinse the mask with energy in running hot water.

Warning: Do not use synthetic or petroleum-based products for the masks cleaning.
Disinfecting the mask

It’s possible disinfecting the mask following these procedures:
•

Standard autoclaving method
Rapid cycles of autoclave lasting 10 minutes at 132°C (270°F)
Heavy cycles of autoclave lasting 30 minutes at 121°C (250°F)
Pre vacuum cycles of autoclave lasting 30 minutes at 121°C (250°F)
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•

Hetilene oxide method (ETO)
The hetilene oxide doesn’t deteriorate the face masks. Sterilisation by this method
is not advised unless sufficient data is available regarding the time required for
complete out-gassing of residual ETO. If you use this method, follow carefully the
instruction provided by the maker of the sterilising product.

•

Pasteurisation
The disinfecting with hot water is a sterilising method that may be used with the
silicone masks.

Canopy bubblehood (option) cleaning
The Canopy bubblehood must be cleaned after each usage with a soft cloth and a non
aggressive as well as not alcoholic detergent.

RMR reader (option) cleaning
The disinfecting procedure is easy and may be performed any time the user needs to do
it by keeping attention to some precautions:
1. Disconnect the sampling tube from the reader
2. Plunge the reader only in a vessel containing disinfectant solution for 20 minutes
circa, as per the picture below, paying attention of not wetting the sampling tube.

3.
4.
5.

Rinse the turbine in a vessel, filled of clean water, shaking gently to remove the
disinfectant (do not clean the turbine by putting it under running water!).
Let it dry to air.
After cleaning the turbine, check if the turbine propeller rotates freely even with a
low speed air flow.

Precautions during the cleaning of the turbine

•

Do not expose the turbine to high heat and do not put it under direct water-spout.

•

Do not wet neither the sampling tube nor the connector on the other end of the
cable

•

Do not use alcoholic solutions to clean the turbine.

Two-way non rebreathing valve cleaning (option)
Refer to the indications reported in the sheet shipped together with the valve.
The valve must be disinfected after each usage on a patient.

Mixing chamber cleaning and disinfection (option)
Before disinfecting the mixing chamber, disassemble it unscrewing the screws in the top
cover.
Note: do not use alcohol, solvents or other abrasive substances for cleaning the mixing
chamber.
For disinfecting the mixing chamber, plunge each part in the disinfecting solution for 20
minutes. Rinse and wipe.
After the cleaning, carefully close the mixing chamber.

Permapure maintenance
•
146 - K4 b2 User Manual

Do not bend, squash or deform it.

•

Do not keep it in open air, if not used, especially in crowded or smoky places.

•

If saliva is entered in the tube, replace it immediately, because it lost its functions.

•

Periodically grease the o-ring on the connector in order to simplify the flowmeter
connection.

•

Replace it every 100 test / 6 month.

Inspections
The equipment requires easy inspections to be carried out in order to assure a proper
electrical and mechanical safety level in the years.
These inspections are highly recommended after a rough use of the equipment or after a
period of storage in unfavourable environmental conditions.
Referring to the electrical safety, it is important to check the conditions of insulation
materials of cables, plugs and any other visible part by means of simple inspection,
when the equipment is switched off and adapters (or electrical feeders) are disconnected
from the supply mains.
Mechanical parts to check are: the turbine and breathing circuits.
Follow these instructions:
•

extract the turbine from the optoelectronic reader;

•

verify, by inspection, that the turbine axis fits correctly its seats and the blade is
strongly fastened on the axis itself (it can be useful to shake slightly the turbine in
order to note any anomalous movement).
Check if there are any torn or broken components in the breathing circuits: remember
that they can create safety risk to patients during tests.

Replace the fuses
The fuses can be replaced easily in the following way:
1. Open the power supply cover using a screwdriver as shown in the picture.

2.

Extract the fuse holder as shown in the picture

3.

Replace the damaged fuse(s).

Note: Be careful to use proper fuses:
A 680 023 500 (Time lag fuses 5x20 250V T500mA)
A 680 013 630 (Time lag fuses 5x20 250V T630mA)
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Appendix

Conformity declaration
Manufacturer:
Address:

COSMED S.r.l.
Via dei Piani di Monte Savello 37,
00040 Pavona di Albano Laziale (RM)
ITALY
phone: +39-06-9315492
fax: +39-06-9314580
manufacturer of the following equipment:
K4 b2
declares under his sole responsibility that:
•

the above listed equipment comply with the essential requirements of the Annex I
of the Medical Device Directive 93/42/EEC;

•

are classified in Class IIa;

•

their design, manufacturing and final checks are performed according the Cosmed’s
Quality System, conform to ISO 9001:2000 and ISO13485:2003 Norms, certified
by CERMET (certificates nr. 387-A and 387-M);

•

are CE marked according to the Medical Device Directive 93/42/EEC and certified
by CERMET (certificate nr. MED 9811).
The equipment conform with the following specifications:
Safety:
CEI 62-5/IEC 60601-1/EN 60601-1
EMC:
EN 60601-1-2
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Service - Warranty
Warranty and limitation of liability
COSMED provides a one (1) year limited warranty from the date of the original sale of
COSMED products. All COSMED products are guaranteed to be free from defect upon
shipment. COSMED’s liability for products covered by this warranty is limited
exclusively to replacement, repair, or issuance of a credit for the cost of a defective
product, at the sole discretion of COSMED. COSMED shall not be liable under the
foregoing warranty unless (i) COSMED is promptly notified in writing by Buyer upon
discovery of defect; (ii) the defective product is returned to COSMED, transportation
charges prepaid by Buyer, (iii) the defective product is received by COSMED no later
than four weeks after the last day of the one (1) year limited warranty period; and
(iv) COSMED’s examination of the defective product establishes, to COSMED’s
exclusive satisfaction, that such defect was not caused by misuse, neglect, improper
installation, unauthorised repair or alteration, or accident.
If the product is
manufactured by a third-party, COSMED shall make available for the Buyer’s benefit
only those warranties which COSMED has received from the third-party
manufacturer(s). COSMED hereby specifically disclaims any and all warranties and/or
liabilities arising from defect(s) and/or damage(s) to and/or caused by products
manufactured by third-party manufacturers. Buyer must obtain written authorisation
from COSMED prior to the repair or alteration of COSMED products(s). Failure of
Buyer to obtain such written authorisation shall void this warranty.
COSMED hereby specifically disclaims any and all other warranties of any kind,
whether express or implied, in fact or by law, including, but without limitation, any and
all warranties of merchantability and/or fitness for a particular purpose.
COSMED shall not be liable for special, indirect and/or consequential damages, nor for
damages of any kind arising from the use of any COSMED’s products, whether said
products are used alone or in combination with other products or substances.
Determination of the suitability of any of COSMED’s product(s) furnished hereunder
for the use contemplated by Buyer is the sole risk and responsibility of Buyer, and
COSMED has no responsibility in connection therewith. Buyer assumes all risks and
liabilities for loss, damage or injury to persons or property of Buyer or others arising out
of the use or possession of COSMED’s products.
The limited warranty as herein above set forth shall not be enlarged, diminished,
modified or affected by, and no obligation or liability shall arise or grow out of, the
renderings of technical advice or service by COSMED, its agents or employees in
connection with Buyer’s order or use of the product(s) furnished hereunder.

Return goods policy for warranty or non warranty repair
Goods shipped to COSMED for repair are subject to the following conditions:
1. Goods may only be returned after your receipt of a Service Return Number
(SRN) from COSMED S.r.l.
2. Place your SRN report and Packing List outside the package.
3. Goods returned must be shipped with freight and insurance charges prepaid.
Collect shipments will not be accepted.
4. The following list of goods are not eligible for return unless proven defective.
- Special order items
- Expendable products
- Goods held over 30 days from COSMED’s invoice date.
- Used goods not in original shipping containers.
- Goods which have been altered or abused in any way.
5. The following parts are not covered by warranty:
- consumables
- fragile glass or plastic parts
- rechargeable batteries
- damages at the
- damages due to use of the device not conforming to the indication reported in this
manual
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Repair Service Policy
Goods returned to seller for Non-Warranty repair will be subject to conditions 1, 2, 3, 4.
The returned goods need to re-enter COSMED together with the customs documents
(Pro-forma Invoice and Customs Paper) as requested by the Italian law.
•

The shipment has to be qualified as a Temporary Export.

•

All the goods returned to COSMED without the customs papers will not be
accepted.
For European Community members:
Pro-Forma invoice complete with:
•

Number

•

Description of the goods

•

Quantity

•

Serial Number

•

Value in €

•

Number of parcel

•

Gross weight

•

Net weight

• Reason for resent (i.e. Resent for repair)
In case you should send the system for repair please contact the nearest service centre or
contact COSMED at the following address:
COSMED S.r.l.
Via dei Piani di Monte Savello 37
P.O. Box 3
00040 Pavona di Albano - Rome, Italy
tel.
+39 (06) 9315492
fax
+39 (06) 9314580
E-mail: customersupport@cosmed.it
For USA customers only please contact:
COSMED USA Inc
2211 North Elston, Suite 305
Chicago IL 60614 USA
Phone: +1 (773) 645-8113
Fax: +1 (773) 645-8116
email: usa.sales@cosmed.it
To ensure that you receive efficient technical assistance, please specify as precisely as
possible the nature of the problem as it is specified on the assistance information form.
We advise you to save the original packaging. You may need it in case to ship the unit
to a technical assistance centre.
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Privacy Information
Dear Customer,
we inform you that your personal data are gathered and will be used by Cosmed Srl in
conformity with the requirements of the Italian privacy law (Decreto Legislativo
196/2003). We believe it is important for you to know how we treat your personal data.

Personal data treatment and purposes
We request and process your personal data:
a. to place an order, register a product, request a service, answer a survey, enter a
contest, correspond with us (all of the above, in the following: “service”) and, if
necessary, to supply the Competent Authorities with the required information;
b. in order to define your commercial profile;
c. in order to use your commercial profile for own marketing and advertising
purposes;
d. for accounting purposes, including e-mailing of commercial invoices;
e. for providing your information to selected business partners (also abroad), in order
to supply the service;

How your personal data are treated
Your personal data will be stored in electronic format, and protected at the best from
destruction, loss (even accidental), not authorized accesses, not allowed treatment or use
not in conformity with the purposes above listed.

The consent is optional, but…
If you deny the consent, we regret we cannot supply the service.

Holder of the treatment
The holder of the treatment is Cosmed Srl, Via dei Piani di Monte Savello 37, Pavona di
Albano Laziale (RM). The responsible of the personal data treatment is indicated in the
documentation stored by Cosmed Srl itself.

Customer rights
In accordance with art.7 of the Law, you can:
a. obtain confirmation of the existence of your personal data and their communication
in intelligible form;
b. obtain:
• updating, correction or integration of your data;
• deletion or transformation in anonymous form of your personal data;
c. deny your consent to the treatment of your personal data;
These rights can be exercised directly requesting in writing to the holder of the
treatment.
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Waste of electrical and electronic equipment
K4 b2 is an electronic equipment and can not be disposed as unsorted municipal waste.
Electric and electronic equipment, according to European Directive 2002/96/EEC, must
be collected separately. Otherwise it can cause dangerous consequences for the
environment and human health.
The crossed-out wheeled bin means that the product must be taken to separate collection
at the product end-of-life.
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Converting factors configuration
You can edit the parameters shown in Control Panel by selecting Control Panel from
the Calibration menu in the calibration program, then pressing the button by side.

You might configure the following options:
Name:
identify the parameter
Unit of meas.:
unit of measurement
Base line and Gain: factors used to convert the acquired raw data (mV) into the final
format according to Y=(mV-BL)*Gain. The value entered for
gain must be multiplied by 1000 (for Gain=1, enter 1000).
Precision:
the number of decimals shown as 0
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Calculations references
VO2 and VCO2
"Energy Expenditure and Fuel Selection in Biological Systems: The Theory and
Practice of Calculations Based on Indirect Calorimetry and Tracer Methods": M. Elia,
G. Livesey, World Rev. Nutr. Diet. Basel, Karger, 1992, vol 70, pp 68-131.
"Nutritional Assessment in Critical Care, A Training Handbook": Donald C. Zavala

Anaerobic threshold (modified V-Slope)
The break-point or intercept of the two slopes can be selected by a computer program
that defines the VO2 above which VCO2 increases faster than VO2, without
hyperventilation.
During an incremental exercise above the Lactate Threshold, the net increase in lactic
acid production results in an acceleration of the rate of increase in VCO2 relative to
VO2. When these variables are plotted against each other (squared graph without
recovery points), the relationship is composed of two apparently linear components, the
lower of which has a slope of slightly less than 1.0, whereas the upper component has a
slope steeper than 1.0. The intercept of these two slopes is the LT or AT point measured
by gas exchange.
The increase in VCO2 in excess of that derived from aerobic metabolism must be
generated from the buffering of lactic acid. This is an obligatory gas exchange
phenomenon seen in all subjects who exercise to work levels above their LT. This
technique is referred to as the V-Slope method.
OVS, Original V-Slope method: "A new method for detecting anaerobic threshold by
gas exchange", Beaver, Wasswrman, Whipp, JAP 1986, 60:2020-2027.
MVS, Modified V-Slope method: "Metabolic acidosis during exercise in patients with
chronic obstructive pulmonary disease", Sue, Wasserman, CHEST 1988, 94:931-938.

O2 kinetics
“Delayed Kinetics of VO2 in the Transition from prior Exercise. Evidence for O2
Transport Limitation of VO2 Kinetics: A Review”; R.L. Hughson and M.A. Morrissey,
Int. J. Sports Med. 4 (1983) 31-39
ISO 8996: Ergonomics – Determination of metabolic heat production, 1990
In the following picture it is shown how the O2 debit and deficit values are computed.
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ATS 94 recommendations
Reference: “Standardization of Spirometry: 1994 Update” “American J. Respiratory
Critical Care Medicine”, Vol. 152, 1107-1136; 1995.

ATS recommendations
Volume range:
8l (BTPS)
Flow range:
±14 l/sec
Volume accuracy:
±3% or < 50ml
Flow accuracy:
±5% or < 200ml/sec
Flowmeter resistance: <1.5 cmH2O da 0 a 14 l/sec
Reproducibility: the 2 largest of 3 acceptable FEV1 and FVC values should be within
5% or 150 ml.
The end of test: no change in volume for 1 second with at least 6 seconds of collected
volume.
Accumulation time: the maximum time allowed for volume accumulation during the
VC manoeuvre should be at least 30 seconds and at least 15 seconds during the FVC.
The spirometer should be store at least 8 FVC maneuvres.
FEV1 should be calculated by using the “back extrapolation” method to detect the start
of the test, extrapolated volume must not be higher then 5% FVC or 150ml.
The graphic resolution of the printed report must be as in the following:
Volume:
10 mm/l
Flow:
5 mm/l/sec
Time:
20 mm/sec
F/V ratio:
2:1
The total number of error (FVC e FEV1 >±3.5%, FEF25-75% >5.5%) during the
measurement of the 24 standard waveforms must be lower than 4.
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Predicted values
ERS93
Standardized Lung Function Testing: Official Statement of the European Respiratory
Society, The European Respiratory Journal Volume 6, Supplement 16, March 1993.
Compilation of reference values for lung function measurements in children: Ph. H.
Quanjer, J. Stocks, G.Polgar, M. Wise, J. Karlberg, G. Borsboom; ERJ 1989, 2,
Supp.4,184s-261s.
KNUDSON 83
Changes in the Normal Maximal Expiratory Flow-Volume Curve with Growth and
Anging: J. Knudson, D. Lebowitz, J. Holdberg, B. Burrows; ARRD 1983; 127:725-734
ITS
Intermountain Thoracic Society: Clinical Pulmonary Function Testing, second edition
(1984) pp 101, 144
LAM
A survey of ventilatory capacity in Chinese subjects in Hong Kong: Lam Kwok-Kwong,
Pang Shing et Al. Annals of Human Biology, 1982, vol. 9, No. 5, 459-472.
Multicéntrico de Barcelona
Spirometric reference values from a Mediterranean population: J. Roca, J. Sanchis, A.
Agusti-Vidal, F. Segarra, D. Navajas. R. Rodriguez-Roisin, P. Casan, S. Sans. Bull. Eur.
Physiopathol. Respir. 1986, 22, 217-224.
Nhanes III
Spirometric reference values from a sample of the general US population: John L.
Hankinson, John. R. Odencrantz and Kathleen B. Fedan. Am J Respir Critr Care Med
1999, 159, 1798-187.
Pneumobil (Brazil)
Valores extraìdos do Programa Pneumobil/Brasil para a Tese de Doutoramento do Dr.
Carlos Alberto de Castro Pereira. (Boehringer).
Gutierrez (Chile)
Gutierrez et Al. Reference values for Chile population
Knudson, Morris and Bass
The maximal Expiratory Flow-Volume curve: Knudson et al. ARRD Vol. 123, p. 659664, 1981
Spirometric Standard for healthy non-smoking adults: ARRD Vol. 10-3, p. 57-67, 1971
Pereira (Brazil)
Pereira CAC; Barreto SP; Simões JG; Pereira FWL; Gerstler JG; Nakatani J. Valores de
Referência para Espirometria em uma amostra da população brasileira adulta. Jornal de
Pneumologia 1992; 18: 10-22.
Mallozi MC. Valores de referência para espirometria em crianças e adolescentes,
calculados a partir de uma amostra da cidade de São Paulo. Valores finais publicados
em : Pereira CAC; Lemle A; Algranti E; Jansen JM; Valença LM; Nery LE; Mallozi
M; Gerbasi M; Dias RM; Zim W. I Consenso Brasileiro sobre Espirometria. Jornal de
Pneumologia 1996; 22:105-164.
Scalambrini Costa F, Scueiri CEB, Silva Jr WC, Pereira CAC, Nakatani J. Valores de
referência para espirometria em uma amostra da população brasileira adulta da raça
negra. J Pneumologia 1996;22: 165-170.
Neder JA; Andreoni S; Castelo-Filho A; Nery LE. Reference values for lung function
tests. I. Static Volumes. Brazilian Journal Medical and Biological Research 1999;
32:703-17.
Neder JA, Andreoni S, Lerario MC, Nery LE. Reference values for lung function tests.
II. Maximal respiratory pressures and voluntary ventilation. Braz J Med Biol Res 1999
;32:719-27
Thai
Wanchai Dejsomritrutai; Khun Nanta Maranetra; Kittipong Maneechotesuwan;
Nitipatana Chierakul; Jamsk Tscheikuna; Tasneeya Suthamsmai; Arth Nana; Benjamas
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Chuaychoo; Phunsup Wongsurakiat; Suchai Charoenratanakul; Wilawan Juengprasert;
Chana Naruman: Reference Spirometric Values for Healthy Lifetime Nonsmokers in
Thailand, J. Med. Assoc. May 2000 (83: 457-466)
DLCO
Standardized Lung Function Testing: Official Statement of the European Respiratory
Society, The European Respiratory Journal Volume 6, Supplement 16, March 1993.
Compilation of reference values for lung function measurements in children: Ph. H.
Quanjer, J. Stocks, G.Polgar, M. Wise, J. Karlberg, G. Borsboom; ERJ 1989, 2,
Supp.4,184s-261s.
Reference Values for Residual Volume, Functional Residual Capacity and Total Lung
Capacity - ATS workshop on Lung Volume measurements, official statement of the
European Respiratory Society; J. Stocks, Ph. H. Quanjer: ERJ, 1995, 8, 492-506
Single Breath Oxygen Test
Buist SA, Ross BB: Quantitative Analysis of the Alveolar Plateau in the Diagnosis of
Early Airway Obstruction. ARRD 108: 1081, 1973
Mansell A, Bryan C, Levison H: Airway Closure in Children. JAP 33: 711-714, 1972
Buist SA, Ross BB: Predicted Values for Closing Volumes Using a Modified Single
Breath Test. ARRD 107: 744-751, 1973.
Rint
Lombardi E, Sly PD, Concutelli G, et al. Reference values of interrupter respiratory
resistance in healthy preschool white children. Thorax 2001; 56: 691-695.
Mip/Mep
Leo F. Black, Robert E. Hyatt: Maximal Respiratory Pressures: Normal Values and
Relationship to Age and Sex, American Review of Respiratory Disease, Volume 99,
1969
Vincken W, Ghezzo H & Cosio MG (1987). Maximal static respiratory pressures in
adults: normal values and their relationship to determinants of respiratory function. Bull
Eur Physiopathol Resp 23: 435-439.

Automatic diagnosis (algorithm)
Reference: “Lung Function Testing: selection of reference values and interpretative
strategies”, A.R.R.D., 144/ 1991:1202-1218.
LLN=Pred-0.674*SD (ATS, 50° percentile)
LLN=Pred-1.647*SD (ERS, 95° percentile)
LLN=Pred*0.8
(80%Pred)
Message interpretation

Criterion

Normal Spirometry
Obstructive abnormality (it may be physiological)
Obstructive abnormality: mild
Obstructive abnormality: moderate
Obstructive abnormality: moderately severe
Obstructive abnormality: severe
Obstructive abnormality: very severe
Restrictive abnormality: mild
Restrictive abnormality: moderate
Restrictive abnormality: moderately severe
Restrictive abnormality: severe
Restrictive abnormality: very severe

FVC and FEV1/FVC > LLN
% Pred FEV1 >= 100
% Pred FEV1 < 100 and >= 70
% Pred FEV1 < 70 and >= 60
% Pred FEV1 < 60 and >= 50
% Pred FEV1 < 50 and >= 34
% Pred FEV1 < 34
FVC < LLN and % Pred FVC >= 70
% Pred FVC < 70 and >= 60
% Pred FVC < 60 and >= 50
% Pred FVC < 50 and >= 34
% Pred FVC < 34

Quality Control Messages
Reference: Spirometry in the Lung Health Study: Methods and Quality Control, ARRD
1991; 143:1215-1223.
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Message

Criterion

Start faster
Blast out harder
Avoid coughing
Blow out longer
Blow out more air
Blow out harder
Take a deeper breath
Blow out faster
That was a good test
FVC reproducible
FEV1 reproducible
PEF reproducible
MVV time too short

VEXT >5% of the FVC and >150ml
PEFT >120 msec
50% drop in the flow in first second
FET100% <6 sec.
flow >0.2l/s within 20 ml of FVC
dPEF<10%
dFVC<200ml and 5% best FVC
dFEV1<200ml and 5% FEV1
No errors
diff. 2 max FVC within 0.2 l
diff. 2 max FEV1 within 0.2 l
diff. 2 max PEF within 10 %
MVV time less than 12 sec
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